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  Introduction   

Introduction 
Welcome to the user guide for the DME client version 3.5.8.  
This guide is divided into three parts: 
1 An introduction to DME - about the company Excitor A/S, what the DME system 

does, and about various aspects of DME that are shared between DME clients on 
all platforms. 

2 A platform-specific guide to the DME client - for Symbian, UIQ, Windows 
Mobile, Java, iPhone, BlackBerry, and Android. 

3 A description of how you can get more help, a list of procedures, a glossary, and 
an index. This part also applies to all DME client platforms. 

If you are an administrator, you should see the DME Client Deployment Guide 
http://install.excitor.dk/documentation/install/docs/14/index.htm for detailed 
installation information for each platform and for information about rolling out the 
DME client to many users. 
 

Copyright information 
Copyright © 2007-11 Excitor A/S. 
All rights reserved. 
Due to continued product development, this information may change without notice. 
The information and intellectual property contained herein is confidential between 
Excitor A/S and the client, and remains the exclusive property of Excitor A/S.  
If you find any problems in the documentation, please report them to us through our 
customer support services. Excitor A/S does not warrant that this document is 
error-free. Furthermore, Excitor A/S does not warrant that the illustrations and 
screenshots used in this document reflect your version or the latest version of the 
program described. For the latest version of this product documentation, go to the 
DME website DME http://www.excitor.com. 
No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, 
recording or otherwise without the prior written permission of Excitor A/S. 
DME, DME Sync, VoiceExtender, SmartEncrypt, and AdaptivePush are trademarks 
of Excitor A/S. 
Microsoft SQL Server, Microsoft Exchange, Windows, Windows Server 2003, 
Windows Server 2008, and Active Directory are trademarks or registered trademarks 
of the Microsoft Corporation in the United States and other countries. 
Lotus Notes® and Domino® are trademarks or registered trademarks of IBM 
Corporation, registered in the U.S. and other countries. 
Apple, Apple iPhone, iPod touch, and iPad are trademarks or registered trademarks of 
Apple Inc., registered in the U.S. and other countries. 
All other trademarks are property of their respective owners. 
 

http://install.excitor.dk/documentation/install/docs/14/index.htm
http://www.excitor.com/
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Company information 
 

12, Spotorno Allé 
2630 Taastrup 
Denmark 
Phone: +45 70 21 68 00 
E-mail: mail@excitor.com 
Website: DME http://www.excitor.com 
 

About DME 
DME (Dynamic Mobile Exchange) offers synchronization of push e-mail, PIM 
information (calendar, contacts, to-dos), and optionally files, to mobile devices. It 
fully integrates mobile device management with state-of-the-art security and efficient 
software deployment. DME is a mobile client/server solution that works with mobile 
phones, smartphones and PDAs using Android, Apple iOS, Symbian, Windows 
Mobile, or Windows Phone*) as operating system. DME is developed by Excitor A/S. 
The solution enables large and mid-size enterprises to deliver business mobility 
services to employees and to effectively manage and control mobile devices without 
compromising security. DME is device, network and operator independent and offers 
unparalleled TCO, unprecedented data and device security, and a very intuitive 
interface for users and administrators. 
*) Please note that not all server features are supported on all platforms. Contact 
your DME Partner for specific inquiries. 
 

http://www.excitor.com/


 5 
 

  Introduction : About DME  

Features and benefits 
 Convenient for the user: Push e-mail, calendar, contacts and to dos 

With DME on your mobile phone, smartphone, or PDA, you get your most critical 
and often used office tools in your pocket wherever you are, whenever you need it. 
E-mails appear on your phone the moment they hit your office mailbox.  

 Quickly back in the game: Instant service recovery 
Should your phone get lost or stolen, a new DME client can be pushed to a new 
phone in a few minutes after you purchase a new DME supported phone or borrow 
one from someone else – no matter where it happens. 

 Fretless security: Mobile security policy enforcement 
E-mails are encrypted over the air and on the device itself using full encryption 
(AES 128-bit or stronger). Shell protection of the entire phone, requiring domain 
password to access all features except picking up calls, gives you further security 
options. 

 Freedom and ease-of-use: Effective control of all devices 
Gain a complete overview of your devices – regardless of make, model, or 
platform. Information about the device model, versions and programs installed on 
the device is listed in the web-based DME control center for easy administration. 
Features, settings and available applications and network connections are all 
controlled centrally and can only be changed by the users to the extent this is 
allowed by centrally applied security policies. Dividing the devices into groups 
makes it easy to change settings/features for many devices at a time. 

 Ease-of-use comes in many flavors: Simple support and administration 
Push software and upgrades via OMA, Apple MDM, SMS or WAP to the users, 
permit them to serve themselves, or automatically upgrade software when the 
users log on. For support purposes, retrieval of device configurations and 
connection set-up makes it possible for you to help users who cannot connect, and 
a log of user actions assists you in identifying the problems and solving them. 
Notification of changes to server status can be sent to the DME administrators to 
ensure they are alerted to problems quickly. 

 Cost containment: Control of ongoing mobile cost 
Data and voice logging allows you to monitor activity levels real-time, and 
identify “expensive” behavior which can be reduced. Heavily-used operators can 
be determined and connection preferences can be set as default. Build advanced 
reports to get a clear view of your organization’s mobile traffic using the 
integrated BI reporting tools. Link to a third-party Telecom Expense Management 
provider to build detailed reports, for instance for internal billing. 

 Freedom of choice: Versatility 
Works on any available network (WLAN/Wi-Fi, GSM, GPRS, 3G/UMTS, 
EDGE...), operator, and on most devices from leading manufacturers. Works on 
Lotus Domino and/or Microsoft Exchange collaboration systems. 

Please note that the above applies to the full DME client. Note also that due to 
limitations specific to the some client platforms, a few of the features mentioned 
above are not supported on DME for those platforms. Contact you DME partner for 
specific inquiries. 
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Typographical conventions 
This guide uses special formating to signify that a text has a special meaning. The 
following kinds of formatting is used: 

Formatting Type of information 
Bold Interface elements that you can select, such as menu options 

or command buttons. 

Special Bold Items that can be selected from a list of options, or text that 
you must type. 

Emphasis Applies emphasis to a point, and is also used for variable 
expressions such as parameters. 

Key+Key Key combinations where the user must press and hold down 
one key and then press another, for example, Ctrl+P or 
Alt+F4. 

 
Caution - performing the action described may lead to loss of 
data or involves other risk. 

For an explanation of specialized terms used in the documentation, see the Glossary at 
the end of this document. 
 

Terminology 
The following is a list of terms used in this guide, and an explanation of the term. 

Term Explanation 
DME Often used for the DME Client. 

DME Server The DME Web Administration Interface. 

Collaboration system The server-based e-mail and calendar system that your 
company runs - either Lotus Domino (with Lotus Notes as 
the user front-end) or Microsoft Exchange (with Microsoft 
Outlook). 

DME menu The DME menu is the main menu in the DME interface. 
On some devices, you have to select Options to access the 
menu, on some you select More. 

Select To choose an item or a menu option, whether by clicking, 
tapping, or choosing in a menu. 

The features or interface elements mentioned in this first part of the user guide apply 
to all phone platforms, and may be illustrated by images from any of the supported 
platforms: Java, Symbian, UIQ, Windows Mobile, or iPhone. The following icons are 
used to signify platforms: 
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Icon Platform 

 

Applies to the DME Client for the Java platform. 

 

Applies to the DME Client for the Symbian platform. 

 
Applies to the DME Client for the Symbian UIQ platform. 

 Applies to the DME Client for the Windows Mobile 
platform. 

 

Applies to the DME Client for iPhone. 

In some cases, there is more than one route to selecting an option. For instance, on 
UIQ devices you can create an e-mail either by selecting More > Create > E-mail or 
by tapping New in the touch options bar, leaving the focus on E-mail, and tapping 
OK. The manual will usually only mention the regular menu route. 
 

General client information 
The following sections contain information that is good to know before you begin to 
use DME. The issues apply to clients of all or most platforms, and deal with the 
following: 
 Time zones 
 Security 
 Synchronization and import 
 Battery conservation 
 Cost-saving features 
This information is included in all the individual client user guides as well as the 
DME Client Deployment Guide 
http://install.excitor.dk/documentation/install/docs/14/index.htm. 
 

Time zones 
With DME, you can always keep your office in your pocket - including your office 
calendar. One challenge with calendars is the fact that sometimes we operate with 
multiple time zones. If we travel to a different time zone, we need to make sure that 
entries in our calendar reflect the change in time zones. An appointment made for 2 
o'clock in the afternoon at your home office should be shown at 1 o'clock if you travel 
one hour west. 
The way in which DME handles time zones changed with version 3.0.2 of the 
Symbian and Java clients, and version 3.0.3 of the Windows Mobile client. DME on 
iPhone and other platforms have always worked in the "new" way. This section 
describes how the current version handles time zones; see Time zones - previous 
versions on page 8 if you are running a version of the DME client previous to the 
releases mentioned above. 

http://install.excitor.dk/documentation/install/docs/14/index.htm
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In order to keep your calendar updated this way, no matter where you are, DME uses 
the time zone setting of your device. The Region or City setting, which is part of the 
time zone specification, is used for identifying whether Daylight Savings Time (DST) 
is active or not. 
When you travel across time zones, a message from the phone operator will often tell 
you that your time zone has changed, and offer to adjust the time zone on your device 
for you. You should allow this, or adjust it yourself. If you do this, your calendar 
should remain up-to-date without excess updates being transferred between the server 
and the client. 
In a few cases, DME is unable to determine the time zone with certainty: 

 On Java devices, special considerations apply in connection with Daylight Saving 
Time (DST). The following applies to users of Sony Ericsson devices running JP-8: 
1 Make sure that the date and time is set correctly on the phone. This is done by 

selecting Menu > Settings > Time & date > My time zone (note that Auto time 
zone must be Off). Here you must select the correct time zone and location. If your 
display does not list locations, select Options > Search region in > <Your area>. 

2 Start DME, and log in. 
3 Select Options > Settings > General, and set the time zone to match your phone 

settings. 
If you do not do this, and there is a discrepancy between the phone settings and 
your DME settings, DME will prompt you to change the DME settings when you 
log in. 

4 Select Options > Tools > Import > Calendar to do a full import of your calendar 
from the collaboration server. 

The following applies to users of Sony Ericsson devices running JP-5 and JP-7: Due 
to a limitation in the handling of time zones in JP-5 and JP-7 devices, meetings 
booked on one side of a Daylight Savings Time change may not appear correctly in 
the calendar after the DST change. 

 On Windows Mobile devices, DME only supports a limited amount of languages. 
If your device is running a language from which the DME client cannot translate the 
time zone settings, a message will ask you to select a time zone from a list. You need 
to make this selection once after the installation of DME, and once every time you 
travel. If you experience this, please contact DME support, and ask them to add your 
language to the list of known languages. 
 

Time zones - previous versions 
The following only applies if you are running one of the following versions of the 
DME client:  
 3.0.1 or earlier for Symbian (including UIQ) clients 
 3.0.1 or earlier for Java clients 
 3.0.2 or earlier for Windows Mobile clients 
When you arrive at an airport in a foreign country and turn on your device, a message 
from the phone operator will often tell you that your time zone has changed, and offer 
to adjust the time zone on your device for you. You should allow this, or adjust it 
yourself (see also the section about Java devices below). 
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Now, when you start DME, DME will detect that the time zone has changed on the 
device, and ask if you want to change the time zone in DME. You should also do this. 
See General settings on page 68 for instructions how to change the time zone in 
DME. 
If you follow these simple rules: 
1 Let the device match the local time zone 
2 Let DME match the device time zone 
– then you should have no problem with duplicate or apparently missing calendar 
entries. 
The notes regarding Daylight Saving Time (DST) on Java devices also apply. See 
Time zones on page 7 above. 
 

Data security 
DME has a strong focus on security. All e-mails are securely stored on the device - 
even if the SIM card is changed or the battery runs out after you have logged in. All 
data remains encrypted at all times using strong encryption, and is only decrypted to 
memory while it is displayed on screen. 
All communication with the server is encrypted, and the server can be set up to require 
a client certificate, which further prevents attempts at unauthorized access from 
devices that are unknown to the server. 
It is not possible to export any data from the device to be read elsewhere. Even the 
clipboard is cleared of any text cut or copied to the clipboard when you exit the client 
(as of version 3.6). 
All DME-related data on the device (e-mails, calendar items, to-dos, contacts, and 
synchronized files, and other data: SMS messages, data on the memory card and 
internal memory) are deleted in the following events: 
 If the SIM card is changed (if set up by the DME administrator). See Changing 

SIM cards on page 11 for more information. 
 If the user name or password is entered incorrectly a number of times (as set up by 

the DME administrator). 
 If the DME administrator decides to do it. If the device is lost or stolen, the data 

on the DME client can be cleared remotely by sending a command from the DME 
server (remote wipe). You should always contact your DME Administrator 
immediately if you lose your device. 

In case a new user logs in, all DME-related data are deleted before the Desktop or 
Inbox is shown. 
 

Changing mailbox passwords 
Depending on your company's security policy, you must change your network 
password at regular intervals. If you use Exchange, your network password is the 
same as your mailbox password, but on Domino collaboration systems this is not 
necessarily so. The DME client depends on the mailbox password to gain access to 
synchronize your e-mail to the device. 
Your mailbox password can be changed from your desktop computer or from your 
device. If your collaboration system is based on Active Directory, a message may pop 
up telling you well in advance that it is time to change your password. If you ignore 
the warning, your current password will eventually become invalid, and you will be 
unable to log on to the system. 
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You can either change your password from a desktop computer on the network or 
from the DME client.  
 If your mailbox password is changed from a desktop computer on the network, 

and you have exited DME (for instance in connection with a phone reboot) so that 
your credentials are no longer encrypted in memory, then the new password has to 
be verified on the server the first time you log in to the DME client. When you log 
in, and DME recognizes you as a user and recognizes your password, but detects 
that the password has been changed on the server, the following message is 
shown: 

 
You are then asked to enter your new password. 
1. Select Yes to verify the new password on the server. 
2. Enter your old password. 
3. Select Log in. 
You can now use DME as usual. 

 If your mailbox password is changed from a desktop computer on the network, 
and your device still has your credentials encrypted in memory: If you are logged 
in, DME will log you out the first time the device communicates with the server 
(for instance in connection with a network push). When you log in again, you 
should use your new password. DME will assume that you have changed password 
on the server, verify your new password, and re-encrypt your credentials without 
you having to confirm any messages. 

 You can change your mailbox password from the client.  
1. Log in to the client as usual. 
2. Open the DME menu, and select Tools > Change password. 
3. Enter your existing password in the Old password field. 
4. Enter a new password in the New password field, and retype it in the 

Confirm new password field. 
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5. Select Change. 

 
DME sends the password change request to the server. If the server accepts the 
request, a message tells you that your password has been changed. If the server 
rejects the request, a message tells you why the command failed. If the command 
fails, it can be an issue with the server setup, and you should contact your DME 
Administrator. 

 

Switching users 
Unless forbidden by the DME Administrator, you can hand over your device to 
another person, even if it contains all your DME data. All e-mails,  calendar items, 
to-do items, contacts, and other synchronized files and resources will be erased when 
the new user logs in. 
The new user is taken through the same verification process as described in Logging 
in on page 25. 
 

Changing SIM cards 
If you change the SIM card in your device, the DME client will ask for the new phone 
number the first time you log in to the DME client. It is important that the phone 
number is correct, as many features depend on the DME server's ability to send 
commands by SMS to the device. 

 
1 Enter the phone number. 
2 Select OK. 
The device phone number can also be changed in the general settings (see General 
settings on page 68). 
Depending on the setting Action on SIM card change in the security settings, your 
DME data will be wiped from the device when you change the SIM card, or your 
device will be locked, or you are allowed to log in as usual. 
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On Java, this feature is only supported by the DME client under 
certain conditions. 

For more information, see Security settings on page 70 in the Java Client User Guide.  

 
This feature does not apply to iPhone. 

 
 

Logging in using a PIN code 
For reasons of security, you may be required to enter a long, complex password with a 
mix of letters and special symbols to gain access to the network and collaboration 
system. This may be easy enough to enter on a full PC keyboard, but you might find it 
difficult to enter using your phone keypad. 
Instead of using your collaboration system password for logging in, it is possible to 
substitute the password for a PIN code of your choice. The DME administrator can set 
a minimum length for the PIN code (4 to 10 letters and numbers), but you are free to 
define a PIN code that is easier to enter using the keypad. 
In order to maintain high security on the device, the following special conditions apply 
when using the PIN code instead of the regular password: 
 The PIN code defined by you may expire after some time. The validity period of 

the PIN code is set by the DME administrator, and could for instance be 8 hours, 
corresponding to one working day. The validity period begins when you log in to 
DME using your regular password. After this, you can use your PIN code to log in 
to DME, until the validity period runs out. Then you have to use your regular 
password again in order to reset the validity period. You do not have to change the 
PIN code. 
The administrator may choose to allow a PIN code that never expires, but this is 
not recommended. 

 If you attempt to log in using your PIN code, but you enter the PIN code wrong, 
then you have to use your regular password for your next attempt. Your PIN code 
is not invalidated, however - you can use it the next time you log in to DME. 

Note that the feature may be disabled by the DME administrator for security reasons. 

 Substituting password for PIN code 
1 Log in to the DME client using your regular collaboration system password. 
2 Select Tools > Set PIN code in the DME menu. 

If you cannot find this option, it is because the DME administrator has disabled it. 
3 A screen with three fields is shown: 
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Enter your regular password in the top field Password, a PIN code of your own 
choice in the middle field New PIN code, and repeat your PIN code in the bottom 
field Confirm new PIN code to make sure you entered it correctly. 
The DME administrator has set a minimum length of the PIN code (between 4 and 
10 letters and numbers). 

4 Press Done to complete the PIN code definition. 
Now, when you want to log in, you have a choice of entering your regular password or 
your PIN code in the Login screen, where the Password field is now called 
Password/PIN code. 

 
The name of the password entry field in the Login screen will change back to 
Password when your PIN code expires. 
To reset your PIN code, enter your password in the Set PIN code screen, but leave the 
PIN code field blank. Selecting Done will then show a message that the PIN code has 
been disabled. 
 

Synchronization overview 
The basic idea of the DME client is to keep the e-mail, calendar system, contacts, and 
other resources on your mobile device up-to-date with the corresponding items on the 
corporate network. To do this, the DME client is synchronized with the collaboration 
system or the file server. E-mails, calendar items, contacts and other resources are 
synchronized with the corporate collaboration system. 
On some platforms, you can also synchronize files on the DME server or in a network 
location with your mobile device. File synchronization requires a special license - 
consult your DME administrator for more information. 
 

What is synchronized 
In the synchronization (sync for short) process, DME checks the following: 
1 Have any items been created? An item could be an e-mail, a contact, a calendar 

item, a to-do, or possibly a file. If an item has been created, it is copied to the 
system on which it does not yet exist (for example, if an e-mail was created and 
sent from the mobile device, the e-mail is copied to the Sent folder on the 
collaboration system).  
Furthermore, the e-mail, calendar and other items on the mobile device are 
synchronized with respect to the time span for which items should be shown 
according to the settings. This is called the synchronization window. For instance, 
the settings may specify that the e-mail application should show e-mails for the 
last 7 days. The sync process will then clear e-mails older than 7 days from the 
Inbox and other mailboxes except Drafts (on the mobile device only). 
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2 Have any items been deleted? If an item, for instance a meeting, has been deleted 
in the collaboration system, the deletion will be reflected on the mobile device. 
Note that e-mails deleted on the mobile device will not be deleted on the 
collaboration system, if the setting Delete only locally is enabled. Note also that 
you will not receive notification of changes when e-mails are deleted from the 
server. 

3 Have any items been edited? If you for instance edit a contact on the mobile 
device or on the collaboration system, the change will be synchronized. In the 
same way, if you edit a spreadsheet on the mobile device, the sync process will 
update the spreadsheet on the DME server if file sync. is enabled. 

 

Conflicts 
In some cases, a conflict may arise. For instance, if a meeting has been moved to 
another time on both the collaboration system and the mobile device, DME will 
resolve the conflict by moving the meeting to the time indicated in the DME client, 
and a message will be sent to you with information about this fact. 
Also, during the initial synchronization of the client or during a subsequent reset, 
duplicate contacts or calendar items may occur. In this case, the duplicate entries will 
be created, and an e-mail listing the duplicate entries will be sent to you (using DME 
3.6). 
 

Synchronization methods 
The DME client can be synchronized in four ways: 
1 Server-initiated sync. (Push) 

Whenever someone sends you an e-mail, a meeting invitation, or similar, it is 
received by the collaboration system. The DME server constantly checks for such 
updates in the collaboration system, and sends a notification by network push, 
Apple Push, or as an SMS (a text message) to the mobile device on which your 
DME client is installed. The notification is picked up, read, and (in the case of 
SMS push) deleted by the DME client, and a sync is initiated to make the device 
reflect the change in the collaboration system. The DME client will optionally 
notify you with a sound whenever a new e-mail has arrived in this way. Push sync 
is enabled and scheduled by the DME administrator. Notifications can also be sent 
in case system settings are updated or a server command is issued. 
Note that notifications may be disabled on the server, and that they may disabled if 
the device is roaming (see Roaming on page 19). 

2 Scheduled sync. 
The client can be set up to synchronize at regular intervals. When synchronizing, 
all enabled resources are synchronized - that is, if the Sync. option for the resource 
in question (for instance To-do sync.) is enabled. The scheduled sync intervals are 
the same for all resources. 

3 Pull sync. 
For e-mail and calendar items, you can set up a separate schedule for 
synchronization. This way you can for example set up scheduled sync intervals for 
contacts, to-dos, and files, disable scheduled sync for e-mail and calendar, and 
enable pull sync for e-mail and calendar with a more frequent schedule. 

4 Manual sync. 
Finally, it is possible to synchronize the client with the server manually by 
selecting a menu item in the client. You can synchronize the different resource 
types individually, or you can choose to sync all resources at the same time. 
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During the synchronization operation, the DME client shows a status messages about 
the current sync process in the interface. In order to optimize speed and bandwidth 
consumption, the DME server builds a list of commands to be executed by the client 
the next time it connects with the server. This is called a "command stack". When the 
client connects with the server, for instance in order to synchronize e-mail, the server 
will force the execution of those commands on the client. For this reason you may 
experience that, for instance, the e-mail sync you requested is followed by a calendar 
sync - meaning that the server takes the opportunity to update your calendar because a 
change has occurred. 
While the synchronization is in progress, you can cancel it by selecting Synchronize > 
Cancel sync. from the DME menu. 

 
 

Saving battery power 
Synchronizing with the server naturally requires battery power. In order to prevent 
your device battery from draining, and thus perhaps leaving you unable to place a 
phone call, DME turns off automatic synchronization when the battery level is low. 
When the battery level drops below 10%, DME turns off scheduled synchronization 
and push synchronization. Instead of synchronizing, the client writes an information 
message in its log file. 
Note that this applies to Symbian and Windows Mobile devices only. 
 

Other contact synchronization software 
When you use DME to synchronize contacts, it is important that you do not use any 
other software for the same purpose. 
On all platforms, there are software packages that offer to keep your contacts in sync 
with the collaboration system or other systems - for instance iTunes, Mobile Me, 
Microsoft ActiveSync, Nokia PC Suite/Ovi Suite, or similar. DME users are advised 
not to use these synchronization methods, as this may cause duplicate entries or 
corruption in your address book over time. 
 

Importing items 
The first time you log in to the DME client after installing it, you will be asked if you 
want to import e-mail from the server. When you accept to do this (recommended), 
your e-mails are imported from the DME server according to the default settings 
specified for the device on the server. 
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The first time you synchronize any resource, for instance calendar entries, the client 
will actually do an import.  When you choose to import a resource (either at first 
synchronization or later, see below), you will be asked if you want to keep the existing 
resources on the phone, or if you want to replace them from the server. (You will not 
be asked if there are no resources of that type on the device at all.) In most cases you 
want to choose Replace from server; you only want to keep the resource on the 
phone if you are sure that none of the items within the given resource exists on the 
server already.  

 

 
You can at any point choose to import items. In the DME menu, choose Tools > 
Import to see a list of resources that can be imported: 
 All items 
 E-mail 
 Calendar 
 Contacts 
 To-dos (not iPhone) 
 Files (not iPhone) 
The Import all function is a shortcut to importing all possible items according to your 
platform and client settings. 
Note that the DME administrator can also force an import of items on your device. In 
this case, you will not be asked if you want to keep the original entries; the device will 
simply start effecting the command and replace from server. 
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Synchronization vs. import 
There are two different ways of getting data from the collaboration system into the 
DME client. An import deletes any existing data on the device before bringing in data 
from the collaboration system. A synchronization checks for differences between the 
data on the device and data on the collaboration system, and then aligns the data – for 
example by retrieving new e-mails from the server, sending e-mails from the device, 
adjusting the time for a scheduled meeting, or bringing a contact on the server 
up-to-date with a contact which you have just modified on the device. 
Since e-mails cannot be changed, importing or synchronizing e-mails amounts to the 
same thing. However, if you should find duplicate e-mail entries in your mailbox, you 
can choose to import your e-mail from the server to realign the synchronization. 
Calendar entries, contacts, and to-dos are another matter. For these items, there is a 
risk that seemingly duplicate entries occur in your calendar or contacts if you 
synchronize, and you risk losing entries that have been entered on the device before 
you installed DME. There are at least three possibilities: 
1 The device is brand new: 

You can safely Import all items, as you have never added contacts or 
appointments on this device. 

2 You used to keep the device synchronized with the collaboration system using 
software such as Nokia PC Suite/Ovi Suite, Sony Ericsson Sync Station, Microsoft 
ActiveSync, or similar: 
You can assume that your contacts, calendar items and so on are up-to-date on the 
collaboration server. Therefore you should initially perform an Import of these 
items. Doing this clears data on the device and imports data from the server, 
ensuring that no duplicates occur. 

3 The device is not new, and has not previously been synchronized: 
Perform a synchronization of the device. This matches contacts on the device with 
your personal contacts on the server. DME checks for duplicates, but items are not 
recognized as duplicates if: 
a) Different data fields are completed for the contact on the device or the server. 

For instance, if "Home Phone" is completed on the device for the contact 
"John Doe", a "John Doe" on the server without a "Home Phone" will not be 
marked as a duplicate. 

b) The spelling is different in any completed field. 
c) When there is any doubt that an entry is a duplicate, a duplicate will be 

created. 
See also Flexible field mapping on page 18 below. 
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4 Clean up your personal address book and calendar on the collaboration system 
(using Outlook or Notes). This is an important step. You will probably find a 
number of apparent duplicates, but there will always be some difference as 
mentioned above. 

5 When you are satisfied with the information entered for your personal contacts in 
the collaboration system on the server, Import the contacts and calendar to the 
device. This will erase duplicates and bring in a fresh set of calendar items and 
contacts from the server. 

6 You can now add device specific features to the contacts, such as photos, speed 
dial keys, etc. These settings will not be lost when you synchronize contacts with 
the server (but they will if you import). 

If in doubt, please consult your DME administrator before importing or synchronizing 
these items the first time.  
 

Flexible field mapping 
It is possible to create custom mappings between fields in Domino or Exchange and 
contacts on the device. You can use this feature for enforcing company policies. 
For instance, you may have a policy of always calling the internal office number when 
calling a colleague in order to cut costs. You can then decide to add the internal office 
number to the "Pager" field in Notes, and map the Pager field to the "Telephone 
(business)" field on all devices. 
Custom mapping should be carefully planned, and can only be set up in cooperation 
with a certified DME partner. Partners may request special documentation from 
Excitor A/S. 
 

Preferred operators 
On the DME server, the administrator can define a number of preferred operators. 
First, one or more home operators is selected for your own country or area. Then, for 
each home operator, one or more operators can be selected for any country in the 
world. The selected operators should be those operators with whom the home operator 
has roaming agreements, and where the roaming prices are the best. 
If this system is in effect, your DME client will warn you about a change of network 
operators when you travel. For example: 
You are based in the United Kingdom. Your company has a special rates agreement 
with Vodafone in the UK and throughout Europe, so the DME administrator has 
selected Vodafone as your home operator and Vodafone as preferred operator in 
Germany. Now say you travel to Germany on business. Your phone is set up to 
automatically change to another roaming operator, so it automatically changes to 
T-Mobile. However, your DME client will show a message saying that in this country, 
your preferred operator is Vodafone, and you are encouraged to switch. 

 On Windows devices, the phone can switch to the correct operator for you. 
Up to three different, possible operators will be shown if multiple operators are 
selected on the server. 
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Roaming 
Apart from specifying preferred operators, the DME administrator can specify various 
cost-saving restrictions to the use of the device when a user is roaming. Whenever the 
user starts using a different mobile operator than the home operator, the following 
features may be restricted by the DME administrator: 
 Scheduled synchronization 

To save synchronization costs, the server may disallow scheduled sync when 
roaming. This means that the phone will not start synchronizing at the intervals 
specified in the Scheduled sync. settings, and the phone will not pull for e-mail or 
calendar items at the specified intervals (see Scheduled sync. settings on page 76, 
E-mail settings on page 71, and Calendar settings on page 73). 

 Manual synchronization 
To save synchronization costs, the server may also disallow manual sync when 
roaming. If manual sync is disabled when roaming, a message saying 
"Synchronization not allowed. Phone is roaming." will appear when you try to 
synchronize while using a roaming network. However, you will be able to 
synchronize manually once before the server discovers that you are roaming. 

 Network push 
To prevent keeping an HTTP connection open from the DME server on a roaming 
network, the server may disable network push when roaming. Instead, the server 
resorts to SMS push. 

When you return to your home operator's network, manual synchronization will again 
be allowed, regardless of any server restrictions. You must then perform a manual 
sync in order to let the server know that you are no longer roaming. 
 





 

  User guide: Android devices   

User guide: Android devices 
DME supports a wide range of Android devices from HTC, Sony Ericsson, Google, 
Motorola, and other vendors. For a list of supported devices, see the Supported 
Devices - Android 
http://www.excitor.com/Default.aspx?id=47&device_search=Android&device_sortby
=product_group website. 
The model used throughout this manual for illustration purposes is the Sony Ericsson 
Xperia X10, running Android 2.1: 

 
A note about terminology  
Android devices generally have three buttons: Back, Home, and Menu. These buttons 
are used in DME as in other apps for Android: 
 Back 

Go back one screen. For instance, pressing Back in an open e-mail takes you back 
to the folder from which you opened the e-mail. If you get stuck somewhere, try 
pressing this button! 

 Home 
Pressing Home shows the Android Home screen. Long-pressing the button shows 
currently running apps. 

 Menu 
Pressing Menu opens a menu, which applies in the current context. For instance, 
pressing the button in an open e-mail shows your options for the current e-mail 
(reply, forward, delete, etc.). In this guide, we refer to this button as the DME 
menu. 

Android devices can be rotated between Portrait and Landscape orientation. DME 
automatically adjusts the display to match the orientation. In this guide, we mostly 
show screenshots from the Portrait orientation. 
The Notification Panel shows notifications received by the phone, including new text 
messages, new e-mail etc. When you open the DME Inbox, any "New e-mail" 
messages from the Notification Panel will be removed automatically by DME. The 
Notification Panel is also used for informing you if DME forces another application to 
exit because the app has been blocked by the DME administrator. In this case, a 
message will say "X" application was blocked by DME. 
 

About Android devices 
DME supports a wide range of Android devices. For a list of supported devices, see 
the DME supported devices http://www.excitor.com/-47.aspx website. 

http://www.excitor.com/Default.aspx?id=47&device_search=Android&device_sortby=product_group
http://www.excitor.com/Default.aspx?id=47&device_search=Android&device_sortby=product_group
http://www.excitor.com/-47.aspx
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The model used throughout this manual for illustration purposes is the Sony Ericsson 
Xperia X10, running Android 2.1: 

 
 

Installing DME on Android devices 
 

OMA DM installation 
Installing using OMA DM is not supported. 
Push installation 
Only SMS push is supported. 
When the DME Administrator has "pushed" DME to your phone, you will receive an 
SMS with the text DME Software Installation and a link to a secure Internet address. 

 
1 Tap the link, and choose to open the link in the browser. 

The browser opens, and downloads the client. 

 
2 Tap the downloaded client. 

If DME was already installed, and you are upgrading to a new version, the 
following message is shown: 

 
Tap OK. 

3 A message is shown with the following text is shown: 
Allow this application to: 
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-along with a number of permission settings. These settings allow DME to operate 
according to the DME client guide. 

 
4 Tap Install. 
5 The DME application is installed. When done, the following message is shown: 

 
6 Tap Open to launch DME. 
Android Market 
The DME client is also available from Android Market. However, when installing 
from Android Market, you have to enter the server path yourself. See First-time login 
on page 26 for more information. 
 

Starting the DME client 
The DME client will usually be set up to launch automatically when you start the 
device. DME contains a number of security features that depend on the client being 
started. Furthermore, the client contains a feature that makes it impossible to shut 
down the client without also shutting down the device. For more information, see 
Data security on page 9. 
You can see if DME is running by an icon in the top notification panel:  

 if network push is enabled and active, 

if network push is enabled and not active, or 

 if network push is not enabled. 
If the DME client does not start automatically, tap the Application Tab, and look for 
this icon: 
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If DME has been opened recently, you can long-press the Home key to see a list of 
recent applications, and then tap the DME icon. Or you can add a shortcut to DME to 
your Home screen (in the Home screen, press the Menu button, tap Add, tap 
Shortcuts, tap Applications, and then tap DME). 
If your device is running Android 2.2 or higher, the DME system is able to send a 
command to your device in the event that you lose the device. The command will 
delete (wipe) all data on the phone so that a 3rd party cannot gain access to the data 
stored on the phone. In order to enable the DME system to wipe your device remotely, 
you must accept a prompt from DME: 

 
By tapping Activate you grant DME the right to administer your phone. The message 
is shown every time you log in, until you accept it. 
You can also enable DME as a device administrator from Settings > Location & 
Security > Device administration on the device. (The actual path to this screen may 
differ on different Android models.) 
On Basic MDM clients, you must accept the message in order for the DME client to 
run at all. 
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Logging in 
When the DME client is launched, the login window is shown: 

 
You must log in with the same user name and password that you would use for the 
collaboration system on your desktop PC. For Lotus Domino users, this is your 
"Internet password". Contact your IT department if you have problems with your user 
name or password. 
If the DME client was already running, and you are logging in again after logging out 
(either manually or automatically after a period of inactivity), the screen shows the 
time of the last synchronization with the collaboration system and the number of new 
e-mails. 
The client remembers the user name from your last login, unless the DME 
administrator has disabled this feature for security reasons. 
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If you have defined a PIN code, you can use that instead of your regular password 
when logging in. 

 
Enter the PIN code you have defined previously, and select Login to enter DME. 
Alternatively, you can define a swipe code for logging in. 

 
Move your finger across the screen in a pattern you have defined previously to log in. 
Note that this can only be done in Portrait mode. If you rotate the device to Landscape 
mode, you can log in using your regular password and possibly a PIN code. 
For more information, see Setting PIN/swipe code on page 66. 
 

First-time login 
If you are logging in to the client for the first time, the login process is different. When 
you start the client, the login screen is shown, but without the indication of last 
connection and number of new e-mails. 
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 Logging in to DME for the first time 
1 Server path: If the installation file was pushed to your device from the server, the 

server path is sent to the device along with the installation file, in a separate SMS. 
When DME launches, the server path is read from that SMS. The server path is the 
location of the DME server on the Internet. 
If DME was installed through Android Market, DME asks you for the server path. 
The server path has the form https://dme.yourcompany.com:5011, where 
dme.yourcompany.com is the name of the server where DME is installed, and 
:5011 is the port number. If you do not know the right host name, ask your DME 
administrator for the server path. 

 
 Host name: Enter the host name in this field, for instance 

dme.yourcompany.com. Do not specify http:// or https://, as this is 
added automatically by DME depending on your choice of Secure connection 
below. 

 Port number: The port number is by default set to 5011. Only change this if 
your DME administrator tells you to. 

 Secure connection: If this is On (default), DME is run over a secure 
connection (https). If Off, DME runs on standard http. 

In case you lose the path to the server, contact the DME administrator. He or she 
can send the server path to your device using the Send server path function in the 
Devices tab in the Web Administration Interface. 

2 Login: Enter your user name and password, and tap Login. Lotus Notes users 
should note that this is your "Internet password" (the same as for your webmail).  
Since this is the first time you enter your user credentials, DME needs to make a 
connection to the server to verify that your user name and password match, so the 
first-time login takes a little longer than usual. DME stores your password in 
multi-hashed, encrypted form (that is, very secure) on the client. Therefore, the 
next time you log in to the client, you do not need to make a server connection to 
verify your login. However, when you do make a connection (for instance when 
you synchronize e-mail), your login credentials will be verified again. 

3 Import: If the login process is successful (that is, DME can establish a connection 
to the DME server and log in using your user name and password), you are 
prompted whether you want to import your e-mail at this point. This is a good idea 
after your first login. See Importing items on page 15 for more information. 

You are now ready to use the DME client. 
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Removing the client 
Uninstalling the client from a device follows the usual procedures for each platform. 
The DME administrator may have specified on the server that you are never allowed 
to uninstall the client. In this case, you are unable to do so. 
Alternatively, the DME administrator may specify that you are only permitted to 
uninstall the client if you are logged in. In this case, you will be prompted for a user 
name and password when you attempt to uninstall the client. If you enter the correct 
credentials within one minute, you will be permitted to continue uninstalling the 
client. 

 Uninstalling the DME client for Android 
1 If your device is running Android version 2.2 or later, and you have accepted the 

"DME Device Administration" request after installing or launching the DME 
client, you must go to Menu > Settings > Security > Select device 
administrators (the path to this setting varies depending on device), and de-select 
DME Device Administration in order to be able to remove the DME client. 

2 From the Home screen, tap the applications bar, and tap Settings. 
3 Tap Applications > Manage applications. 
4 Tap the DME application. 
5 Tap Uninstall. 
The DME client is removed from your device, including all data that was protected by 
DME. This includes any attachments you may have downloaded for viewing. 
 

The DME Desktop 
The main DME screen is the Desktop. The Desktop gives you quick access to the most 
commonly used features in DME. 

 
Tap an icon to run the function associated with the icon. 
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Desktop actions 
The following is a brief explanation of each Desktop icon, with references to more 
information: 

 Go to the Inbox (see Navigating the folder tree on page 30) 

 Go to the Unread folder (see Navigating the folder tree on page 30) 

 Open the Folders screen (see Navigating the folder tree on page 30) 

 Create a new e-mail (see Creating and sending e-mails on page 36) 

 Open the internal DME Calendar (see Calendar on page 45) 

 Create a new meeting invitation (see Booking meetings on page 53) 

 Synchronize e-mail (see Synchronization overview on page 13) 

 Open the Search menu (see Search on page 42) 

 Open the Settings page (see Settings on page 68) 

 Go to the Contacts application (see Contacts on page 58) (not Java 
devices) 

 (Symbian devices only) Open the SmartEncrypt on-the-fly encryption 
application (see the SmartEncrypt Quick Guide) 

 (Some Nokia S60 devices only) Open the VoiceExtender™ call 
answering machine (see the VoiceExtender™ Quick Guide) 

Apart from these icons, you can use the DME menu (Options) to access all functions 
in DME. You can access the DME menu from all views in DME. For an overview of 
the DME menu, see Menu tree on page 77. 
For information about how to configure your Desktop, see Desktop settings on page 
76. 
 

Working with folders 
The DME mailbox consists of at least the following folders: Inbox, Outbox, Drafts, 
Sent, and Unread. The first four of these folders function as the corresponding folders 
on the collaboration system (Notes or Outlook). The Unread folder is a smart folder 
which shows all unread messages in any folder in the DME client. When an e-mail in 
the Unread folder is read, it disappears from view - but naturally remains in the folder 
from which it originated. 



30 
 

DME Client User Guide 3.5.8 : ©2011 Excitor A/S 
 

Apart from these standard folders, subfolders created on the collaboration system 
(Notes or Outlook) can be shown on the client. Subfolders from the collaboration 
system can be shown if the folder synchronization feature is enabled on the DME 
server and on the client (see Folders settings on page 73). If enabled, you have access 
to all the e-mail folders on your collaboration system. With settings similar to the 
e-mail settings (see E-mail settings on page 71) you can specify how many e-mails 
you want to see in each folder (by age in days) and whether you want to synchronize 
e-mails in folders at all. This is specified as a system-wide setting. In the following 
section you can see how to specify different settings for each folder, including whether 
you want to receive a notification when a new e-mail arrives in a folder. 
 

Navigating the folder tree 

To move between folders, tap the desktop Folder icon , or select View > Folders 
in the DME menu. When you do this, DME shows a list of all folders in the system. 
The number of e-mails in each folder is shown in white text, followed by the number 
of unread e-mails in blue text and in parentheses. 
Tap a folder to open it in mailbox view, or press the Back button to return to the 
Desktop. 

 
The different folder icons have the following meaning: 

 
Regular folder with no subfolders. Folder is not synchronized. 

 
Regular folder with no subfolders. Folder is kept synchronized with the 
collaboration system (see the next section). 

 

Folder with one or more subfolders. The subfolders are collapsed (not 
shown). Also, the icon shows if the folder is kept synchronized. 

 

Folder with one or more subfolders. The subfolders are expanded 
(shown). Also, the icon shows if the folder is kept synchronized. 
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Folder which cannot be selected are grey. On Domino systems, you can 
create folders and subfolders at the same time by naming a new folder 
like this: Work\Testing. When created in this way, the parent folder 
(Work) cannot itself contain e-mails (but Testing can).  

 
Therefore you cannot select the parent folder here, but you can expand 
the folder by tapping it. 

You can set options for the synchronization of folders. See more in the next section. 
 

Setting folder options 
You can set defaults for the way e-mail folders should be synchronized between 
collaboration system and client (see Folders settings on page 73). If you have many 
folders on the collaboration system, it is recommended that you set up very restrictive 
default settings for performance reasons, and loosen up on individual folders as 
described below. 
To change synchronization options for a folder, open the folder view described in the 
previous section, and long-press the folder you want to customize. Then tap Settings. 
The following screen is shown: 

 
 Use default values 

If this field is set to Yes, the current folder uses the general settings specified (see 
Folders settings on page 73). If Apply to subfolders is also selected, the default 
settings will be applied to all subfolders below the current folder as well, when 
you press Done. If the value in this field was No, and you change it to Yes, the 
settings in the remaining fields in this screen will be reset to the default values 
when you press Done. 
If you want to apply other settings than the default settings to this folder, you must 
select No in this field. 

 Sync. folder 
This option can only be changed if Use default values above is set to No. If this 
field is set to Enabled, e-mails in the current folder are synchronized with the 
collaboration system, using the synchronization window defined in the field Days 
back below. To avoid too high load on the DME server, you should only 
synchronize those e-mail folders that you really need on the device. You can for 
example consider to not synchronize folders containing graphics-intensive 
newsletters etc. 
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Synchronized folders are shown with an icon like this: . 
 Days back 

This option can only be changed if Use default values above is set to No. When 
e-mails are synchronized, e-mails from the last number of days selected here will 
be synchronized and available in the current folder. 

 Include in mail scan 
This option can only be changed if Use default values above is set to No. If this 
field is set to Enabled, you will receive notification when a new e-mail arrives in 
the current folder. New e-mail can "arrive in" subfolders by means of rules, which 
are set up on the collaboration system to automatically distribute new e-mails in 
folders. 

 Apply to subfolders 
If this field is set to Yes, the settings made in other fields in this screen are 
propagated to folders below the current folder when you press Done. Use this 
function with caution, as the setting may affect many folders. Note that you can 
choose this option regardless of the value of the field Use default values above. 

Note that you cannot modify the settings of the system folders (Inbox, Sent, etc.). 
Instead of synchronizing e-mail to the client, you can use the Search e-mail (on 
server) function to find e-mails in any folder on the collaboration system. See E-mails 
(on server) on page 43 for more information. 
 

E-mail 
Click the  icon from the Desktop (DME menu: View > Folders > Inbox) to open 
the Inbox, which displays the e-mails and meeting invitations that have been 
synchronized to the client. 
The Inbox is one of the five system folders: Inbox – Outbox – Drafts – Sent – Unread. 
To switch between these folders, select View > Folders in the DME menu. If folder 
synchronization is enabled on the server, you can access all your mailbox folders this 
way (see Working with folders on page 29). 
Above the list of e-mails, you can see the total number of e-mails in the current folder. 
The number of unread e-mails is shown in parentheses and blue text. If there are 
unsent e-mails in the Outbox, this is shown to the right in the other mailbox folders 
after the Outbox symbol . 
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The illustration below shows the main DME mailbox interface. 

 
Note that long-pressing and e-mail in the mailbox folder view is a shortcut to various 
functions. See Other e-mail options on page 36. 
 

E-mail icons 
On the left side of of each e-mail in the mailbox view, an e-mail icon is displayed. The 
icon tells you quite a bit about the e-mail at a glance: 

 An unread e-mail is shown as an unopened envelope. The sender is displayed in 
a boldface font. 

 An already read e-mail is shown as an opened envelope. 
In addition to this, different symbols can be superimposed on the e-mail envelope, 
providing you with more information: 

Symbol Meaning 

 
This e-mail contains one or more attachments. 

 
This e-mail is a meeting invitation. 

 
This e-mail has high priority. 

 
This e-mail is encrypted. 

 
This e-mail is signed. 

 An e-mail in the Drafts folder. 

 An e-mail in the Sent folder. The e-mail icon in both the Drafts and the Sent 
folders can be superimposed by the attachment, priority, encryption, or signature 
symbols. 
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Reading e-mails 
To open an e-mail, tap the e-mail in a folder. 
To read the next e-mail in the current mailbox, flick left. To read the previous e-mail 
in the current mailbox, flick right. 
 

Links 
E-mails and meeting invitations may contain links such as e-mail addresses, phone 
numbers, and web links. Whenever a link is found, it is written in blue and underlined 
(like links on a web page). Tap a link to see your options for the link. 
When you tap a phone number or an e-mail address, you can choose among the 
following options: 

 
 Call 

If you tapped a phone number, DME copies the number, switches to the Dialler, 
and pastes the number into the Dialler. You can then press the Call button to dial 
the number. 
If you tapped an e-mail address, DME will check if the e-mail address is one of 
your contacts, and if a phone number is associated with the contact. If it is, the 
number is shown in Dialler. 

 E-mail 
If you tapped a phone number, DME will check if the phone number is one of your 
contacts, and if an e-mail address is associated with the contact. If it is, DME 
creates a new e-mail for that contact. 
If you tapped an e-mail address, DME creates a new e-mail for that address. 

 Add to Contacts 
The phone number or e-mail address is added as a contact. After selecting this 
option, DME shows your contacts. You can then select Add Contact in the menu, 
or you can open an existing contact. The phone number or e-mail address is then 
added to the new or existing contact. Phone numbers are added as Tel. (business). 

When you tap a web address, the link is opened in Browser. 
 

Attachments 
When you receive an e-mail with an attachment, you will see an attachment icon in the 

mailbox  and in the header area of the open e-mail . 
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Graphics that have been embedded into an e-mail may be shown as attachments on the 
client. This requires that you run Domino as your collaboration system. 

 Opening an attachment 
1 Open the e-mail. 
2 Select Attachments in the DME menu. 

A list of the attachments to the e-mail is displayed. 

 
3 Select the attachment. 
4 Select Yes to download and open the attachment. 

DME connects to the server. 
5 Select Yes to allow the attachment to be decrypted to disk. 

The attachment file is stored in a temporary folder on the device disk, which is 
outside the secure DME area. It is deleted from the temporary folder again when 
you log out of DME. If DME cannot delete the attachment immediately when you 
log out, for instance if it is still open in the application, it will keep trying at 
regular intervals. 

To save transmission time and space on the device, attachments are not stored on the 
device unless you specifically choose to download them. In the attachment list, the  
icon shows if the attachment is only located on the mail system server. A 
phone-and-clip icon  means that the attachment has been downloaded to the 
device. 
The device supports several types of attachments depending on the programs installed. 
By default, the device will recognize several types of image files such as .bmp and 
.jpeg, sound files such as .wav, and text files. Usually the device will also be able to 
open Microsoft Office and Adobe PDF files. Please refer to the user manual of the 
device for further information.  
If the file does not have a file type association, an error message will be displayed, and 
the file will not be downloaded. If you have a program that you know will open the 
file of the type in question, you must set up a file association to that file type, and try 
to download the attachment again. For information about file associations, see your 
mobile phone documentation or the documentation for your mobile phone operating 
system. 
Press the Back button to return to the e-mail. 
 

Removing attachments 
When you download attachments to the device, the attachments will take up space on 
the device. To free this space, you have the option to remove downloaded files from 
the device. The attachments will not be deleted on the mail system, only on the DME 
client. 
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 Removing all attachments from the device 
1 Go to the mailbox view of any folder. 
2 Open the DME menu, and select Actions > Delete all attachments. 
3 Press Yes to confirm. 
Note that this option is also available if you long-press an e-mail in the mailbox view. 
 

Viewing e-mail details 
You can see a summary of information about the e-mail you are reading. 

 Viewing e-mail details 
1 Open an e-mail. 
2 Open the DME menu > More, and select E-mail details. 
An information box shows information about the current e-mail. 
The information consists of the date and time the e-mail was received, a list of 
recipients of the e-mail (individual recipients or a mail group), importance level, and 
security information. 
Press OK to exit the information box. 
 
 

Other e-mail options 
Apart from the options concerning attachments and e-mail details mentioned above, 
you can open the DME menu for more options (some of the options are available as 
buttons at the bottom of the screen as well): 
 Reply / Reply to All 

Create a reply to the e-mail - see Replying to e-mails on page 39. These options 
are also available directly from the e-mail, or you can long-press an e-mail in a 
mailbox folder for an option to reply to the current e-mail. 

 Forward 
Forward the e-mail - see Forwarding e-mails on page 39. 

 Delete 
Delete the current e-mail. This option is also available directly from the e-mail, or 
you can long-press an e-mail in a mailbox folder for an option to delete the current 
e-mail. 

 More > Toggle flag 
Set or remove the follow-up flag. E-mails marked with a follow-up flag have a 
special status in the collaboration system. 

 More > Add to contacts 
Add the sender of the current e-mail to your contacts. 

 

Creating and sending e-mails 
 Creating and sending an e-mail 

1 Select Create > E-mail from the DME menu almost anywhere in the DME client. 
or 

Click the New e-mail icon in the Desktop:  
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2 Enter message details as described in the next section - see E-mail details on page 
37. 

3 In the DME menu, select Send. 
The e-mail is now saved in the Outbox. Depending on the e-mail settings, the e-mail is 
sent immediately or queued for the next scheduled or manual synchronization (see  
E-mail settings on page 71). When the e-mail has been sent, it is moved to the Sent 
folder. 
Note that you can also create an e-mail by finding one or more e-mail addresses 
through the Global Address Book first, and then choosing to create an e-mail using the 
selected e-mail addresses. For more information, see Global Address Book on page 
42. 
 

E-mail details 
The e-mail form works like a normal e-mail with fields for Send to, Carbon Copy (CC), 
Blind Carbon Copy (BCC), Subject, and Body. If you need to type multiple recipients in 
a field, you can separate the recipients using a comma (Lotus Notes style) or a 
semicolon (Outlook style). 

Tip: Some collaboration systems are able to resolve names of known users. This 
means that you only have to enter the short name as the e-mail recipient. For instance, 
you could just enter sad in the Send to field, and the collaboration system would 
resolve (expand) the name to Sabine.Adelhof@excitor.com automatically. Ask your 
DME administrator if this is possible in your setup. 
Tip: For devices without a full keyboard, you can insert a new line in the e-mail body 
by pressing the center or right scroll key (depending on device model). 
 

Entering recipients 
With the cursor placed in the Send to ( ), CC ( ), or BCC ( ) field, you can start 
typing the name of a recipient. DME will try to predict who you want to enter as a 
recipient, and shows suggestions in a drop-down list below the recipient field: 

 
DME builds this list from all the e-mail addresses found in your mailbox folders, from 
participants in meetings where you are a participant or chair, and from your local 
contacts. 
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When you start typing, DME will match the typed characters with the names and 
e-mail addresses in the list of addresses. For instance, typing a "c" might match the 
following entries in the list: 
 "Chris Rea <chris.rea@music.com>" 
 "Hooray Carlton <hooray@freude.de>" 
 "Melanie C. <melc@spice.com>" 

As you type more characters, the list will grow shorter. In the example above, typing 
an "a" after the initial "c" will limit the list to "Hooray Carlton <hooray@freude.de>" 
only. 
The list is sorted alphabetically. 
Flick through the list, and tap an e-mail address to add it to the recipient field. To add 
another contact, start typing the name of the next recipient. 
 

Selecting message options 
You can sign, encrypt and mark the message with high importance. 

 Setting message options 
1 Open the DME menu in the e-mail you are creating, and select Message options. 
2 Tap to enable or disable each option: Sign, Encrypt, and High importance. 
3 Tap OK or Cancel to return to the e-mail. 
Please note the following about signed and encrypted e-mail:  
 When you send a signed e-mail, and the DME server cannot find your private key 

on the server, an e-mail with a notification of the error "The DME Server could 
not send the signed S/MIME e-mail") is sent to you by the DME server. Your 
e-mail will be sent to the recipient; however, it will not be signed. 

 When you send an encrypted e-mail, the DME server needs to know the public 
key of each of the recipients of the e-mail. If the public key of one of the recipients 
is unknown to the server, an e-mail with a notification of the error ("Cannot find 
certificate for recipient: xx") is sent to you by the DME server. The e-mail will not 
be sent to any of the recipients. 

Using signed and encrypted e-mail requires special setup. Please contact your DME 
administrator. 
 

Saving as draft 
If you want to continue editing an e-mail at a later time, you can save the e-mail as a 
draft. 

 Saving an e-mail as a draft 
1 Open the DME menu, and select Save as draft. 

or 
2 Tap Save as draft in the open e-mail. 

or 
3 Close the e-mail by pressing Back, and select Yes when asked to save as draft. 
The e-mail is saved to the Drafts folder, and you are returned to the mailbox. When 
you want to finish the e-mail, you can open it from the Drafts folder, edit it, and send it 
in the usual way. 
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Replying to e-mails 
When replying to an e-mail, you have the possibility to reply to sender with or without 
history (that is, with the original e-mail appended to the bottom of the e-mail) and 
reply to all with or without history. 
There are two ways of replying to an e-mail. 

 Replying to an e-mail 
1 Open the e-mail you want to reply to. 
2 Open the DME menu, and select Reply or Reply to All. 
3 Select With history or Without history. 

 Replying to an e-mail using Quick reply 
1 Open the e-mail you want to reply to. 
2 Open the DME menu, and select Quick reply. 

The functionality of selecting Quick reply is defined in the e-mail settings (see 
E-mail settings on page 71). Here you can specify if Quick reply should 
correspond to selecting To sender with history, To sender without history, To 
all with history, or To all without history. 

In both cases, a new e-mail is created for the original sender and possibly all original 
recipients. If the original e-mail contained attachments, you will be asked if you want 
to include the attachments in your reply. If the e-mail you are replying to was signed, 
encrypted, or marked with high priority, DME will copy these settings to the new 
e-mail. 
You can now add text and attachments to the e-mail and send it. See Sending 
attachments for information about how to work with attachments in e-mail replies. 
 

Forwarding e-mails 
You can forward an e-mail with all content, including attachments. 

 Forwarding an e-mail 
1 From any folder, open the e-mail. 
2 Open the DME menu, and select Forward. 
3 If the original e-mail contained attachments: 

Press Yes to include attachments, or 
Press No to send the e-mail without attachments 
See Sending attachments for information about how to work with attachments in 

forwarded e-mails. 
You can now add recipients, text and attachments, and select Send to send the e-mail. 
For information about how to enter recipients, see Entering recipients on page 37. 
If the e-mail you are forwarding was marked with high priority, DME will copy this 
setting to the new e-mail. 
 

Sending attachments 
You can include attachments in e-mails in two different ways: by forwarding an 
e-mail that already contains attachments, or by adding attachments from the device to 
new e-mails (either original e-mails, forwarded e-mails, or replies). Furthermore, you 
can add attachments to meeting invitations. 
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 Sending attachments in original e-mails and replies 
1 Create an e-mail (see Creating and sending e-mails on page 36, Replying to 

e-mails on page 39, or Forwarding e-mails on page 39). 
2 Select Attachments in the DME menu. 
3 Browse to the file you want to add, and tap it. 

In the Attachments screen, you can tap an attachment to open it. You can open it 
if your device knows a program that can open the file (if it recognizes the file's 
"mime type"). 
Long-press, and select Delete to remove it from the e-mail again. 

4 Tap Add attachment to add another file. 
Tap Done to return to the e-mail. 

  
 Sending attachments in forwarded e-mails 

1 Forward an e-mail (see Forwarding e-mails on page 39). 
2 You can add attachments in the same way as for original e-mails (see above). 

or 
If the original e-mail contained one or more attachments, and you chose to include 
the attachments in the forwarded e-mail, you can now manage the attachments. 

3 In the DME menu, tap Attachments to see the list of attachments that were 
included from the original e-mail. 

4 You can now select one or more attachments to remove them from the e-mail, 
open them, or you can add more attachments in the same way as for original 
e-mails (see above). 

Attachments in forwarded e-mails need not be downloaded to the device before they 
are sent. DME will pull the attachments from the collaboration system when the mail 
is sent, saving transfer costs. 



 41 
 

  User guide: Android devices : E-mail  

 Adding attachments to meeting invitations 
1 Create a meeting invitation (see Booking meetings on page 53). 
2 Add attachments in the same way as for original e-mails (see above). 
Note that the DME administrator may have blocked for adding new attachments from 
the device to e-mails. Furthermore, restrictions to the size of attachments apply. The 
default maximum size is 16MB, but this limit may have been increased or reduced by 
the DME administrator. 
 
 

Folder actions 
In each mailbox folder, you can perform a number of actions on one or more items. 
 

Selecting multiple items 
Some functions can be performed on a single item or several, marked items - for 
instance deletion or marking as read.  
To select an item in a folder or list, tap the grey checkmark  below the e-mail icon. 
Selected items are marked with a green checkmark icon . 
 

Marking read/unread 
When you read an e-mail in the DME client, the e-mail will be marked as read - that 
is, the e-mail icon is grey  and not red . Furthermore, the e-mail will be marked 
as read in the collaboration system the next time you synchronize. You can mark an 
e-mail as unread after reading it, for instance in order to remember reading it when 
you get back to the office, or you can mark unread e-mails as read.  
The actions described below can apply to a number of selected items. See Selecting 
multiple items on page 41 for information about how to select multiple items. 

 Marking selected or all e-mails as read or unread 
1 In the folder view, select one or more e-mails. 
2 Open the DME menu, and select Actions. 
3 Select Mark selected read to mark the selected e-mail(s) as read, or 

Select Mark selected unread to mark the selected e-mail(s) as unread, or 
Select Mark all read to mark all e-mail(s) as read, or 
Select Mark all unread to mark all e-mail(s) as unread. 

Note that the Mark all read/unread options are also available if you long-press an 
e-mail in the mailbox view. 
 

Deleting items 
When deleting an e-mail, the e-mail data is removed from the DME client. Depending 
on an e-mail setting, the e-mail can also be deleted on the mail system at the next 
synchronization (see E-mail settings on page 71). 
The actions described below can apply to a number of selected items. See Selecting 
multiple items on page 41 for information about how to select multiple items. 
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 Deleting one or more selected items 
1 Select the item or items to be deleted. 
2 Open the DME menu, and select Actions > Delete selected. 
3 Tap Yes to confirm the deletion. 
Note that DME will try to prevent the accidental deletion of many items. If you delete 
a large number of items (more than 20 e-mails/meeting invitations or more than 10 
contacts) at a time, a message will ask you if you really want to delete the items on the 
server, the next time the device synchronizes with the server. 

 Deleting a single e-mail 
1 In the folder view, long-press the e-mail you want to delete. 
2 Select Delete in the popup menu. 

 Deleting the currently open e-mail 
1 Open the DME menu in the e-mail you are reading, and select Delete, or 

Tap the Delete button. 
2 Tap Yes to confirm the deletion. 
 

Search 
Using the DME client you can search for contacts in the global address book on the 
collaboration system, search e-mails in your mailbox on the collaboration system, or 
search e-mails already downloaded to the device. 
 

Global Address Book 
The Global Address Book is the shared address book on the collaboration system as 
set up by the network administrators. 
To create an e-mail message or a meeting invitation, you can open the DME menu and 
select Create as described in Creating and sending e-mails on page 36 or Booking 
meetings on page 53. However, you can also find the recipient or recipients of your 
e-mail or meeting invitation first, and then choose to create a new e-mail or meeting 
with the selected contacts as recipients. 

 Finding contacts in the global address book 
1 In folder view, open the DME menu, and tap Search > Global Address Book, or 

From the Desktop, tap the   icon, and tap Global Address Book. 
You can now search for a contact by Name, E-mail address, Department, Country, 
or Title. 
Note that more fields or different fields may be available if the Global Address 
Book search screen has been customized. See separate documentation about 
customizing the fields in this screen. 
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2 Enter a search text in at least one of the available fields, and tap .  
A connection is made to the collaboration system, and the search results are 
displayed. Depending on a setting on the DME server, the search will either look 
for entries starting with the text you have entered, or entries containing the text 
you have entered. When searching for a name, you can enter both a first and last 
name separated with a space. 
By default a maximum of 10 results are shown, but this value can be changed by 
the DME administrator. 

From the search results, you can select contacts the same way as with your local 
contacts. Selected contacts are marked with a . You can now perform a number of 
functions with one or more of the found contacts. 
1 Create new e-mail or meeting: Tap Create in the DME menu, and then tap 

E-mail or Meeting to insert the selected contacts as recipients in a new e-mail or 
as participants in a new meeting, respectively, or  
Long-press a contact, and tap Create > E-mail or Meeting to insert the selected 
contacts as recipients in a new e-mail or as participants in a new meeting, 
respectively. 

2 View details: Tap a contact to view more details about the contact. The details are 
shown in a window with a number of tabs, depending on the type of details that 
have been made available by the collaboration system. This could for instance be 
four tabs, showing General information (name and company), Telephone 
numbers, E-mail addresses, and Other information. Press Back to close the 
details window. 

3 Place a call: You can place a call to a contact by long-pressing the contact. Any 
phone numbers associated with the highlighted contact are listed. Tap one to place 
a voice call with the contact, or tap Back to exit the menu. 

4 Add to contacts: Select one or more contacts, and tap Add to contacts in the DME 
menu. The selected contact or contacts are added to the device Phonebook. 
Depending on your version of Android, the contacts are added in the main 
phonebook or in a contact group called DME. Note that due to bug in Samsung 
Galaxy, contacts are added to a group called Unknown on that device. 

Finally, you can choose New search in the DME menu to return to the search screen 
with every option in the search screen reset to default values. 
 

E-mails (on server) 
The DME client only synchronizes e-mails from the last number of days specified in 
the e-mail settings (see E-mail settings on page 71). This is called the e-mail 
synchronization window. Sometimes you may need to find an e-mail which is stored in 
a folder in your collaboration system mailbox which is not synchronized to the DME 
client, or which is too old to be synchronized to the client. 
Using this function, you can search for any e-mail stored in any folder of your mailbox 
on the collaboration system. 

 Searching for e-mails on the server 

1 Open the DME menu, and select Search > E-mails (on server) (or select the  
Desktop icon, and choose E-mails (on server)). 

2 Complete the search fields in the form: 
1.  Search text: In this field enter the text to search for. 
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2.  Field: Select the e-mail fields in which to search for the specified text. 
Click to choose between the following options: 
Any field: All fields in an e-mail are searched for the specified text string. 
Subject: Only the Subject field is searched. 
Subject, Body: Both the Subject and the Body fields are searched. 

3.  Person: In this field enter all or part of the name of the sender of the e-mail 
you are looking for (or recipient in case you are searching your Sent folder). 

4.  Folder: Choose the folder in which the e-mails to be searched are located. 
Tap to choose among the mail folders defined in the mailbox on the 
collaboration system, or choose All. 

5. Date: In the two fields Start and End you can select a range of dates. This 
limits the search to e-mails received within the selected time frame. If you 
only select a start date, e-mails are searched from that date up until today. If 
you only select an end date, e-mails are searched from the distant past up until 
that date. 

3 Tap . 
Note that a search can only be executed if one or more of the fields Search text, 
Person, Folder, or Date has been completed. If not completed, an error message says 

"Search fields cannot be blank" when you tap . 
After a while, the search results are displayed in a Search screen. When you tap a 
found e-mail, it is retrieved from the server, and shown as a regular e-mail, and you 
can perform all the regular e-mail functions (reply or forward, or view more details 
about the e-mail). 
If no results are found, DME shows a message that no matches are found, and you are 
returned to the search screen after confirming the message. 
If you did not find the e-mail you were looking for, select New search in the DME 
menu to try again. 
Press Back to return to the Desktop. 
 

Technical details 
Note that the client shows the results in the order in which they are presented by the 
collaboration system. If your collaboration system is based on Lotus Domino, the 
search results are returned in order of relevance. If your collaboration system is based 
on Microsoft Exchange, the search results are returned in chronological order (that is, 
by date). 
The server sets a limit to the number of search results. By default, the limit is 100 
results. 
Please note that for best performance, your mailbox should be indexed. For more 
information about indexing your mailbox, see the documentation for Lotus Notes or 
Microsoft Outlook. 
Note also that if you select a folder which contains other folders, you will get different 
results depending on your collaboration system: 
 If you use Domino, the search for e-mails will be performed in the selected folder 

only. 
 If you use Exchange, a message will be shown: "Do you wish to include 

subfolders in your search?" If you answer Yes, e-mails in the subfolders of the 
selected folder will be searched as well. 
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E-mails (on phone) 
From any folder, you can search for a text string contained in an e-mail in DME. 

 Searching for a text string 

1 Select Search > E-mails (on phone) from the DME menu, or  from the 
Desktop > E-mails (on phone). 

2 Complete the search fields in the form: 
1.  Search text: In this field enter the text you want to find. This field cannot 

be blank. 
2.  Field: Select the e-mail fields in which to search for the specified text. 

Click to choose between the following options: 
Any field: All text fields are searched for the specified text string. 
Sender, recipient: Only Sender and recipient fields are searched. 
Subject: Only the Subject field is searched. 
Subject, Body: Both the Subject and the Body fields are searched. 

3.  Folder: Choose the folder in which the e-mails to be searched are located. 
Only the folder shown in this field is searched (any subfolders are not 
searched). Tap to choose among the mail folders defined in the mailbox on the 
collaboration system, or choose All. 

3 Tap . 
Note that a search can only be executed if you have entered a search text in the 
field Search text. 

The search results are displayed in a Search screen. You can open the found e-mails 
as regular e-mails, and all the usual features are available. After reading the e-mail, 
press Back to return to the Search screen. 
If no results are found, DME shows a message that no matches are found, and you are 
returned to the search screen after confirming the message. 
To perform a new search, tap New search in the DME menu. 
Press Back to return to the Desktop. 
 

Calendar 
DME contains a complete, built-in calendar, which you can use to get an overview of 
your appointments, and from which you can create new meetings and invite other 
people to the meetings. Meeting invitations from other people are received in the 
DME Inbox, and transferred to the calendar when accepted. Meetings that you create 
for yourself are saved directly in the Calendar. Meetings with other participants are 
also saved directly in your Calendar, and sent as invitations to the other participants 
(and resources) at the next calendar synchronization. 
 

Calendar views 
To view the calendar entries in the DME calendar, select the  icon from the 
Desktop, or select View > Calendar in the DME menu. 



46 
 

DME Client User Guide 3.5.8 : ©2011 Excitor A/S 
 

The calendar opens on today's date in the Month view. You can choose to see your 
calendar entries in three different views: 
 Day view: See all calendar entries for one day. Browse to the previous or next day 

by swiping left or right. The title text tells you the day in the week and the date of 
the day you are currently viewing. 

 
 Week view: See all calendar entries for one week. Browse to the previous or next 

week by swiping left or right. The title text tells you the number and starting date 
of the week you are currently viewing. 
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 Month view: See all calendar entries for one month. Browse to the previous or next 
month by swiping the month calendar control left or right. The title text tells you 
the name of the month and the year you are currently viewing. For each calendar 
entry on the selected date, the month name, date, time, and subject of the entry are 
shown. 

 
Each view can be seen in landscape mode as well. Below is the Month view in 
landscape rotation. 

 
To rotate between the views, tap the  in the top part of the screen, or select View 
and then View day, View week, or View month in the DME menu. 
To open a meeting, tap it from any view. 
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Go to date 
To show a certain date in the DME calendar, select Go to date in the DME menu. 
Enter the desired date by tapping or long-pressing the + and - icons in the date spinner. 
Select Set to go to the selected date. The date will be shown in the Day view. 

 
To go to today's date, select Go to today in the DME menu. 
 

Calendar actions 
From each view, you can select the following actions in the DME menu: 
 Create meeting: Tap the  button to create a new meeting. The default date set 

for the new meeting is the currently viewed day. In the Week view and the Month 
view, the meeting date is set to the first day within the viewed range of days, for 
instance the first in the month currently viewed. If that date has passed, today's 
date is suggested as the meeting date. See Booking meetings on page 53. 

 Synchronize: Perform a manual calendar synchronization by tapping the  
button. See Synchronization overview on page 13 for more information. 

 Menu > Reset: Import all calendar items from the collaboration system. See 
Synchronization overview on page 13 for more information. 

 

Viewing and editing meetings 
To view details about a meeting in the calendar, move to it, and click to open it. You 
can now see all the fields that have been completed for this meeting, but you cannot 
initially change any fields. 
Your options in the DME menu depend on whether you organized the meeting in 
question (you are the chair) or you were invited as a participant. 

 Calendar options for the meeting chair 
If you are the chair of the meeting, the following options are available: 
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 Edit: Select this option if you want to change any of the details in the meeting, 
including removing and adding participants. All fields in the meeting invitation are 
now opened, and you can make any change you want. 
Note: The Domino collaboration system permits the use of formatted text and the 
embedding of attachments in the meeting description. If the meeting description 
contains attachments, you will not be able to edit the description on the device. If 
there are no attachments, and you edit the Description field on the device, any 
formatting and any embedded objects in the field will be lost when the calendar 
event is synchronized back to the collaboration system. 
Select Attachments in the DME menu to add or remove attachments in the 
meeting. See Sending attachments. 
When you are done editing the meeting, you may select Check free time in the 
DME menu to verify that all participants are free at the time in question, if you 
have changed the meeting time or date. For more information, see Checking free 
time on page 56. Select Save in the DME menu to save your changes. You are 
prompted to enter a comment about the reason for changing the meeting, which is 
sent to each participant when you synchronize. If you remove a participant from 
the list of required participants, the participant receives a meeting cancelation 
notice, and the meeting will be removed from the calendar of that participant. 

 Reschedule: This option is available if you are the chair, and you have invited 
other people to the meeting. Select this option if you want to move the meeting to 
another date or time. A new screen opens, letting you set a new date and time for 
the meeting. 

 
Change the date and time. You may now select Check free time in the DME 
menu to verify that all participants are free at the time in question. For more 
information, see Checking free time on page 56. 
Select Save or Send and save in the DME menu to save your changes. You are 
prompted to enter a comment about the reason for rescheduling the meeting, which 
is sent to each participant when you synchronize. 
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 Cancel meeting: This option is available if you are the chair, and you have invited 
other people to the meeting. Select this option if you want to cancel and delete the 
meeting. The meeting will be removed from the calendar of all participants. You 
are prompted to enter a comment about the reason for canceling the meeting, 
which is sent to each participant when you synchronize. 
Note: If your collaboration system is Exchange 2003, DME is unable to process 
meeting cancelation notices. This means that if you receive a notice about a 
canceled meeting, you must accept the cancelation in Outlook or Outlook Web 
Access (the OWA webmail). 

 Delete: This option is available if you are the chair, and you have not invited other 
people to the meeting (it is a personal appointment or similar). Select this option if 
you want to cancel and delete the appointment. The appointment will be removed 
from your calendar in DME immediately, and from your collaboration system 
when you synchronize. 

When you save any changes, DME asks you if you want to synchronize the calendar 
immediately. 

 Calendar options for meeting participants 
If you are a participant in the meeting, and not the chair, the following options are 
available: 

 
 Edit: Select this option if you want to change details in the meeting. As a 

participant, you only have access to toggle the Private status of the meeting and the 
Alarm (and possibly set the alarm time). After editing these fields, select Save in 
the DME menu to save your changes. 

 Decline 
 Propose new time 
 Delegate: For information about these three options, see Responding to meeting 

invitations on page 51. Note that selecting Decline or Delegate removes the 
calendar entry from the calendar immediately. 

After making any changes, DME asks you if you want to synchronize the calendar 
immediately. 
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Responding to meeting invitations 
When meetings are booked on the collaboration system, all invited participants receive 
a meeting invitation by e-mail, containing information about the meeting. 
In the DME client, a meeting invitation is recognized by a clock/e-mail icon in the 
Inbox. See E-mail icons on page 33 for more information. 

 Responding to a meeting invitation 
1 Open the meeting invitation. Browse through the pages of the invitation to see the 

subject and time of the meeting, who organized the meeting, who have been 
invited (participants), and any information about location and resources involved 
in the meeting. 

2 In the DME menu, you can now choose among a number of options. Most of the 
options are available on all supported collaboration systems, but there may be 
differences, which are noted below.  
Furthermore, the description of the actions pertain to the standard way of inviting 
to meetings. For instance, in Domino the chair can select options in the meeting 
invitation in Notes specifying that he or she does not want to receive responses 
from invitees (participants), wants to prevent counter-proposals, or wants to 
prevent delegation. Such options are naturally observed by DME, even if they are 
not mentioned in the descriptions below. 
The following options may be available: 
 Accept: Accept the meeting invitation. The meeting is created in the calendar, 

and a notification of your acceptance is sent to the meeting organizer/chair. 
 Decline: Decline the meeting invitation. Notification of this is sent to the 

organizer/chair and any other participants. 
 Tentatively accept: If you want to attend the meeting, but you are not sure 

that you are available at the proposed time, you can tentatively accept the 
meeting. This way the meeting is booked in your calendar, but the time still 
appears free for other users. Note: On Exchange 2003 systems, this action is 
not available for recurring meetings. 
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 Propose new time: If you would like to attend, but you are not available at the 
proposed time, you can propose a new time (also called countering the meeting 
proposal). Selecting this option opens a new screen in which you can select a 
new time, date, and time zone for the meeting. 

 
When you are done, you can open the DME menu and select Send to send the 
new proposed time, or Check free time to see if the new proposal conflicts 
with the calendars of any of the required participants. For more information, 
see Checking free time on page 56. When you send the new proposed time, 
the meeting chair/organizer will receive an e-mail with the subject Countered: 
and the subject of the meeting. 
Please note that once the calendar entry has been accepted, you are not able to 
change the time zone of the calendar entry if you subsequently edit the 
calendar entry from your calendar to propose a new time. Note: On Exchange 
2003 systems, this action is not available for recurring meetings. 

 Delegate: If you are unable to attend the meeting, you may want to send 
someone else in your stead. Choose Delegate, and select another user from 
your local or global address book. The Delegate field functions as other 
recipient fields, with type-ahead selection of recipients and the ability to 
choose from the local and global address books. See Entering recipients on 
page 37 for more information. 

 Show calendar: Open your DME calendar on the day of the meeting so you 
can check your schedule for that day. Select Back to return to the meeting 
invitation. 

 Delete: Delete the current meeting invitation without performing any action 
with it. To get the meeting invitation back into your mailbox, you must 
synchronize your e-mail (unless the option Delete only locally is set to No in 
E-mail settings (see E-mail settings on page 71), in which case the invitation 
will be deleted on the server also at the next synchronization). Note: On 
Exchange 2003 systems, this action is not available for recurring meetings. 
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3 When you accept, decline, tentatively accept, propose a new time, or delegate a 
meeting invitation, you are given the option to add a comment. If you enter a 
comment, it is sent to the organizer/chair. Select Continue / Send to complete the 
action, or Cancel / Close to return to the meeting invitation. Note: On Exchange 
2003 systems, not all actions allow you to reply with comments. 

4 When you respond to a meeting invitation by using any of the above actions, the 
e-mail containing the invitation is removed from your Inbox, and if you accepted 
the meeting, your calendar is updated on the collaboration system at the next 
calendar synchronization. 

 

Recurring meetings 
Recurring meetings created on the collaboration system are synchronized to DME as a 
series of individual appointments. This means that if you edit one in a series of 
meetings, only that instance of the meeting series will be changed. If you want to edit 
the entire series, you must do so in Microsoft Outlook or Lotus Notes. 
Recurring meetings created on the device are sent to the server as a true series or 
recurring meetings, not as individual events. If you create a recurring meeting on the 
device without an end date, the DME server will add an end date automatically. The 
end date will be five years in the future. 
 

Booking meetings 
You can book meetings in your corporate calendar from the DME client. You can 
invite people to attend the meeting, and you can reserve rooms and resources. This 
basically works the same way as booking meetings in your collaboration system. 

 Creating a new meeting 
1 There are several ways to start the creation of a new meeting: 
 From the Desktop or a mailbox: Select Create > Meeting in the DME menu. 
 From the Calendar: Select Create meeting in the DME menu, or tap the Add 

(plus) icon (not all platforms). 

 From the Desktop, select the New meeting icon . 
 Or press the shortcut you have defined for New meeting from anywhere in 

DME (not all platforms). 
2 Enter meeting details: see Entering meeting details on page 54. 
3 Add participants: see Adding participants on page 55. 
4 Enter a location and book resources: see Location and resources on page 55. 
5 Check to see if the calendars of all participants are free at the proposed time: see 

Checking free time on page 56. 
6 Add attachments: see Sending attachments. 
7 From the DME menu, select Save and send (if participants or resources have been 

invited), or Save (if the meeting is for yourself only). 
The meeting is created in your calendar, and meeting invitations are sent to the 
selected participants and resources at the next calendar synchronization. 
Note that you can create a new meeting invitation by selecting recipients first from a 
search and then creating the meeting invitations. For more information, see Global 
Address Book on page 42. 
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During the creation of a meeting, you can also choose Save as draft in the DME 
menu or Close. Selecting Save as draft saves the meeting as a draft, allowing you to 
interrupt your work on the meeting proposal for a later time. The Close option closes 
the current meeting draft, and prompts you if you want to save it as a draft before 
closing it.  
The meeting is shown in your calendar as a regular meeting, but with a blue, hollow 
triangle on top of it, and it will not be synchronized to the collaboration system. Please 
note that draft meetings are not synchronized with the server. This means that if you 
import your calendar from the server, any draft meetings in your DME calendar on the 
device will be lost. 
 

Entering meeting details 

 
The Meeting details tab contains the following fields: 
  Subject: Enter a subject for the meeting. 
 All day: Mark the meeting as an all-day meeting. When you select this field, you 

cannot enter start and times for the meeting. The meaning of "all-day" depends on 
which collaboration system you are using: 
Lotus Domino: All-day events in Domino do not support the use of other 
participants, rooms, or resources. An all-day event created in Domino will only 
display a Details tab and a Location tab when it is synchronized to the client - it is 
not possible to add participants and resources to the event. 
When you create an all-day event on the client, you are able to add participants 
etc. to the event. However, when the event is synchronized to the server, it is 
created in Domino as a regular meeting, and the client will reflect this also (even 
though the All day field is still checked). 
MS Exchange: In Exchange, you are able to invite participants and book resources 
for all-day events - the All day field simply signifies that the event has no time 
constraints. 

 Symbian users should be aware that all-day events created in the native 
device (as "Memos") will appear as all-day events in the DME calendar, but the 
meeting type cannot be changed in DME. 
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  Date and time: Enter starting and ending dates and times for the meeting. 
  Time zone: Enter the time zone for the starting and ending times. See Time 

zones on page 7. 
  Alarm: Enable or disable the alarm. When the alarm is enabled, you can enter 

a date and time for when the alarm should go off. 
  Private: Mark the meeting as private. This means the the meeting details are 

not visible to other people in the collaboration system when you sync the calendar 
item, but your time will appear booked. 

 Description: Enter a description of the meeting, agenda, etc. 
 

Adding participants 

 
In the Participants tab, you can add meeting participants from Local contacts on the 
device and from the global address book on the server. You can enter Required 
participants ( ), Optional participants ( ), and FYI participants ( ). 

 Entering meeting participants 
1 Click one of the Participants fields. The field functions as other recipient fields, 

with type-ahead selection of recipients and the ability to choose from the local and 
global address books. See Entering recipients on page 37 for more information. 

See Global Address Book on page 42 for information about selecting participants 
before creating the meeting. Participants selected from a Global Address Book search 
result are added to the required participants field ( ). 
 

Location and resources 

 
In the Location and resources tab, you can enter a location for the meeting, and book 
rooms and resources that are available in the collaboration system. 
In the form, you can enter information into the following fields: 
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  Location: Here you can enter free text describing the location of the meeting - 
for instance an office, a country or a city. 

  Rooms: Here you can select one or more of the rooms available in the 
collaboration system. See below. 

  Resources: Here you can book one or more of the resources available in the 
collaboration system. See below. 

Before selecting rooms or resources, you must download the available rooms and 
resources from the collaboration system to your device. 

 Downloading rooms and resources 
The first time you click either of the Rooms or Resources fields, DME will 
download a list of rooms and resources from the server. Subsequently, you can 
refresh the list of resources by selecting Update in the DME menu. 

 Selecting rooms and resources 
1 Tap the Rooms or Resources button. 
2 Open the drop-down list by tapping a name. 
3 You may have to select which site you want to select your rooms and resources 

from by clicking. Sites are marked with a . If your organization only uses one 
site, the list of rooms or resources is shown directly. 

4 Scroll up and down in the list of rooms or resources, and mark the rooms or 
resources you want to add. Note that if the people capacity of the room is entered 
in the collaboration system, it is shown in the list. 

 
5 Tap Done. 

The selected rooms or resources are entered into the field in question. 
To unselect a room or resource again, repeat the above process, and unmark the room 
or resource you want to omit before tapping Done. 
 
 

Checking free time 
When participants, rooms and resources have been added, you can check if they are 
available within the specified time frame. This can be done from any of the tabs. 
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 Checking free time 
1 Open the DME menu, and select Check free time. 

After DME has checked on the server, you will see a message indicating whether 
all participants and resources are available or unavailable within the selected time 
frame. 

 
2 Select Yes to show alternative time frames 

or 
Select No to keep the current time frame. 
If you select Yes to show alternatives, you will see a list of time frames within 
which all participants and resources are available. 

 
3 Scroll up or down to select a new time frame. 
4 Select Done to use the selected time frame or 

Tap the time frame you want to use (Android) 
The meeting details are changed to reflect the update. 
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Contacts 
DME can keep the contacts in your Personal Address Book in Lotus Notes or 
Microsoft Outlook synchronized with contacts on your device. As of version 3.5.5 of 
the client, DME contains a secure, internal address book - the DME Address Book. If 
the setting Contacts sync. is enabled (see Contacts sync. settings on page 75), your 
contacts in the collaboration system will be kept in sync with the contacts in DME. 
Furthermore, you can choose to synchronize your DME contacts with the contacts in 
the native Contacts application. This way, all your contacts - both business and 
personal - can be maintained in either DME or in the Contacts application. Or you can 
choose to keep your business contacts in the DME Address Book and your private 
contacts in Contacts - for reasons of security, work/life balance, or both. For more 
information, see Contacts sync. settings on page 75. 
Whenever you create an e-mail or book a meeting, you can choose recipients from the 
Global Address Book or from your local contacts. See Entering recipients on page 37 
for more information. 
For information about importing contacts to the device from the collaboration system, 
see Importing items on page 15. For information about synchronizing contacts with 
the collaboration system, see Synchronization overview on page 13. 
The DME contact synchronization works differently on different versions of Android. 
The following sections describe the creation and editing of contacts on Android 
1.5/1.6 devices, Android 2.1 devices, and Android 2.2 devices. 
When you have added, edited, or deleted one or more contacts, your changes are 
synchronized to the collaboration system at the next scheduled or manual sync, or 
when the DME server initiates a contact sync. 
 

Adding and editing contacts 
Different contact applications on different phones and phone platforms support 
different contact fields. A contact field is for instance the First name field or the 
Telephone field in a contact. When synchronizing the address book in MS Outlook or 
Lotus Notes to a mobile device, different third-party applications may map the fields 
in Outlook/Lotus Notes to the phone in different ways. 
The DME Address Book supports a large, but fixed number of fields. By using DME 
for synchronizing contacts, you can be certain that everybody in the organization maps 
contacts from the collaboration system to their device in the same way. 
When you select Add Contact or Edit Contact in the menu of the DME Address 
Book, DME lets you enter information into the following fields: 
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Account name 
Anniversary 
Assistant 
Assistant phone 
Birthday 
Carphone 
Categories 
Children 
City 
City (business) 
City (home) 
Company 
Company phone 
Country/Region 
Ctry./Reg. (bus.) 
Ctry./Reg. (home) 
Customer ID 
DTMF 
Department 
E-mail 
E-mail (business) 
E-mail (home) 
Extension 
Extension (bus.) 
Extension (home) 
Fax 

Fax (business) 
Fax (home) 
File as 
First name 
Government ID 
IM ID 
IM ID 2 
IM ID 3 
Internet tel. (bus.) 
Internet tel. (home) 
Internet telephone 
Job title 
Last name 
Location 
Manager 
Middle name 
Mobile 
Mobile (business) 
Mobile (home) 
Nickname 
Note 
P.O. Box 
P.O. Box (bus.) 
P.O. Box (home) 
Pager 
Postal/ZIP code 

Postal/Zip (bus.) 
Postal/Zip (home) 
Push to talk 
Radio phone 
SIP 
Share view 
Spouse 
St./Prov. (bus.) 
St./Prov. (home) 
State/Province 
Street 
Street (business) 
Street (home) 
Suffix 
Tel. (business) 
Tel. (home) 
Tel.2 (business) 
Tel.2 (home) 
Telephone 
Title 
Video call 
Video call (bus.) 
Video call (home) 
Web addr. (bus.) 
Web addr. (home) 
Web address 

Note that adding contacts in the native phonebook of the device is different on 
different versions of Android. The descriptions below are relevant to DME if your 
Device Address Book setting is Open or Mixed (see Contacts sync. settings on page 
75). 
 

Contacts on Android 1.5/1.6 devices 
 Adding contacts: Android 1.5/1.6 

1 Click the Contacts icon  on the Desktop in DME. 
The native Android 1.5/1.6 Contacts (or: Phonebook) application is shown. 

2 In the Contacts menu, tap New contact.  
You are prompted to complete the action using one of two methods: 

 
3 Tap Create DME contact. 

If you mainly use DME for managing your contacts, you can select the checkbox 
Use by default for this action. 
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4 Now complete the fields in the new contact. Note that there are four tabs available 
for information input: General, Address, Phones, and E-mails information. 

 
5 Tap Save when you are done. 
Your new contact is now ready to be synchronized to the collaboration system. 

 Editing contacts 

1 Click the Contacts icon  on the Desktop in DME. 
The native Contacts application is shown. 

2 Find the contact you want to edit. Open the contact, and tap Edit. 

 
3 Tap Edit DME contact, edit the contact, and save it. 

You should always choose to edit DME contacts using the DME account to avoid 
issues with unsupported fields etc. 

Your contact is now ready to be synchronized to the collaboration system. 
 

Contacts on Android 2.1 devices 
 Adding contacts: Android 2.1 

1 Click the Contacts icon  on the Desktop in DME. 
The native Android 2.1 Contacts application is shown. 
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2 In the Contacts menu, tap New contact.  
You are prompted to complete the action using one of two methods: 

 
3 Tap Create DME contact. 

If you mainly use DME for managing your contacts, you can select the checkbox 
Use by default for this action. 

4 Now complete the fields in the new contact. Note that there are four tabs available 
for information input: General, Address, Phones, and E-mails information. 

 
5 Tap Save when you are done. 

The new contact is now saved under the DME account, meaning that it will be 
managed by DME. 

If, in step 2 above, you chose to add the contact using the Create contact action, you 
would still be able to create it under the DME account by choosing Phone (DME) 
when saving the contact: 

 
Please note that the Samsung Galaxy S incorrectly creates an account called 
Unknown (DME) (instead of Phone (DME)) after import or synchronization. 
Your new contact is now ready to be synchronized to the collaboration system. 
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 Editing contacts 

1 Click the Contacts icon  on the Desktop in DME. 
The native Contacts application is shown. 

2 Find the contact you want to edit. Open the contact, and tap Edit. 

 
3 Tap Edit DME contact, edit the contact, and save it. 

You should always choose to edit DME contacts using the DME account to avoid 
issues with unsupported fields etc. 
Your contact is now ready to be synchronized to the collaboration system. 

 

Contacts on Android 2.2 devices 
 Adding contacts: Android 2.2 

1 Click the Contacts icon  on the Desktop in DME. 
The native Android 2.2 Contacts application is shown. 

2 In the Contacts menu, tap New contact.  
You are prompted to complete the action using one of two methods: 

 
3 Tap Create DME contact. 

If you mainly use DME for managing your contacts, you can select the checkbox 
Use by default for this action. 
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4 Now complete the fields in the new contact. Note that there are four tabs available 
for information input: General, Address, Phones, and E-mails information. 

 
5 Tap Menu > Add contact when you are done. 

 
The new contact is now saved under the DME account, meaning that it will be 
managed by DME. 

If, in step 2 above, you chose to add the contact using the People action, you would 
still be able to create it under the DME account by choosing DME in the Group field 
before saving the contact: 

 
Even though the interface calls this a group, it really is the account. 
Your new contact is now ready to be synchronized to the collaboration system. 

 Editing contacts 

1 Click the Contacts icon  on the Desktop in DME. 
The native Contacts application is shown. 
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2 Find the contact you want to edit. Open the contact, and tap Edit. 

 
3 Tap Edit DME contact, edit the contact, and save it. 

You should always choose to edit DME contacts using the DME account to avoid 
issues with unsupported fields etc. 

Your contact is now ready to be synchronized to the collaboration system. 
 

Initial import of contacts on Android 2.x 

After importing contacts for the very first time, you can see them by tapping  
from the Desktop, and use them as recipients in new e-mails or participants in new 
meetings. 
However, you may be surprised to find that if you open the native Contacts 
application on your Android device, you cannot see the contacts you imported from 
DME. This is because you need to set up your device to add the DME contacts to the 
group of visible contacts. 

 Viewing DME contacts in native contacts application 
1 Open the native contacts application. Depending on your phone, it may be called 

Contacts, People, or Phonebook. 
2 Add the DME account or group to the contacts displayed. This is done in different 

ways depending on your phone, for instance: 
On Sony Ericsson X10 phones, tap the Group icon at the top left of the Phonebook 
screen. 
On HTC Desire, choose Menu > View. 
On Samsung Galaxy and Google Nexus One, choose Menu > Display options. 

3 Tap the group or account called Phone (DME) (or similar). 
4 Select the All Contacts checkbox (or similar). 
5 Tap OK. 
Your DME contacts should now be visible in your native Contacts application, and 
available to the Dialer and other apps. 
 

Work/home scheme 
Some of the fields in the DME Address Book mentioned above are special in that they 
function as a sort of alias for up to three distinct fields. An example of this is the field 
Mobile. When you enter a number into the Mobile field and synchronize, then how 
can DME know if the number should be placed in the Cell phone, Mobile, or Mobile 
2 in Lotus Notes, or in Business Mobile, Home Mobile, or Other Mobile in MS 
Outlook? 
There is no issue if you enter values in the specific mobile number fields: Mobile 
(home) and Mobile (business). These fields are directly supported by the 
collaboration system. The issue only exists if you use the generic Mobile field. 
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When this field (Mobile) is updated on the device, and you choose to synchronize 
contacts, DME considers the following work/home scheme. Note that each row in the 
table below lists all completed fields related to mobile phone numbers: 

This field in the DME 
Address Book 

 
maps to 

this field in Notes or 
Outlook 

Mobile ->  Work mobile 

Mobile 
Mobile (business) 

-> Home mobile 
Work mobile 

Mobile 
Mobile (home) 

-> Work mobile 
Home mobile 

Mobile 
Mobile (business) 
Mobile (home) 

-> Other mobile 
Work mobile 
Home mobile 

Note: If you are using Lotus Notes, the last row in the table only applies if you are 
running Domino 8 and above. If you are running Domino 7, the value in the Mobile 
field is stored in a hidden field in DME, as Domino 7 and below only supports two 
mobile numbers. 
DME not only employs the work/home scheme to make a qualified guess about where 
to place the mobile phone number, but from all of the following fields, which are of 
the same type as Mobile: 
E-mail 
Fax 
Mobile 
Tel./Telephone 
Address 
 

Files 
If file synchronization is enabled, files can be synchronized using scheduled sync or 
manual sync. Files can be synchronized in one of three ways, which is determined by 
the sync method selected in the file rule set up by the DME administrator: 
 One-way, just like receiving an e-mail: The files are downloaded to your device if 

updated on the server since your last sync. 
 Execute: The files are downloaded and executed on your device, if they were 

updated on the server since your last sync. 
 Two-way, just like editing a meeting invitation: The files are downloaded to your 

device if updated on the server since your last sync, or uploaded to the server if 
you updated the files on the client since your last sync. 

For a file to be of use on the device, the file type in question must have an associated 
viewer. Not all devices are for instance able to view Word documents. For more 
information, consult your DME administrator. 
 

Tools 
The Tools menu in the DME menu contains options that apply to the DME client in 
general. The menu contains the following items: 
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 Settings: Control the look and feel and the operation of your DME client. See 
Settings on page 68. 

 Import: Refresh the contents of your DME client with a new copy from the 
server. Care should be taken before importing contacts and calendar items. See 
Importing items on page 15. 

 Change password: With this function, you can change your network password. 
See Changing mailbox passwords on page 9. 

 Set PIN code: With this function, you can temporarily replace your collaboration 
system password by a simpler PIN code for use on the DME client. See Setting 
PIN/swipe code on page 66 below. 

 Set swipe code: With this function, you can temporarily replace your 
collaboration system password by a simpler swipe code for use on the DME client. 
See Setting PIN/swipe code on page 66 below. 

 Log: Displays the event log, which is kept by the DME client. The log can be 
useful in support questions. When you open the log and press the Menu key, you 
are presented with a number of options: 

 
The options are (from left to right): 
 Left arrow: Browse one page back in the log. 
 Right arrow: Browse one page forward in the log. 
 Disk: Save the log to the file /sdcard/me/log.txt on the memory card. 
 Refresh: Re-read the log file. 
 Trash: Delete the log. 
 Envelope: Save the log to disk, open a new e-mail, and attach the log as a file. 

This is especially useful if you need to send the log to support. 
See also If you need further assistance on page 81. 

 

Setting PIN/swipe code 
For reasons of security, you may be required to enter a long, complex password with a 
mix of letters and special symbols to gain access to the network and collaboration 
system. This may be easy enough to enter on a full PC keyboard, but you might find it 
difficult to enter using your phone keypad. 
Instead of using your collaboration system password for logging in, it is possible to 
substitute the password for a PIN code or a swipe code. 
 A PIN code is another passcode of your choice. You are free to define a PIN code 

that is easier to enter using the keypad than the collaboration system password. 
 A swipe code is defined by moving your finger across the screen of your 5th 

Edition or Symbian^3 phone in a certain pattern. The pattern is stored on the 
device in a way that is equivalent to a PIN code. 

The DME administrator can set a minimum length for the PIN code (4 to 10 letters 
and numbers). For swipe codes, this minimum length applies to the number of tiles 
you must cover when entering the swipe code. See details below. 
In order to maintain high security on the device, the following special conditions apply 
when using the PIN code or swipe code instead of the regular password: 
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 The code defined by you may expire after some time. The validity period of the 
code is set by the DME administrator, and could for instance be 8 hours, 
corresponding to one working day. The validity period begins when you log in to 
DME using your regular password. After this, you can use your code to log in to 
DME, until the validity period runs out. Then you have to use your regular 
password again in order to reset the validity period. You do not have to change the 
PIN or swipe code. 
The administrator may choose to allow a PIN/swipe code that never expires, but 
this is not recommended. 

 If you attempt to log in using your own code, but you enter the code wrong, then 
you have to use your regular password for your next attempt. Your own code is 
not invalidated, however - you can use it the next time you log in to DME. 

Note that the feature may be disabled by the DME administrator for security reasons. 

 Substituting password for PIN code 
1 Log in to the DME client using your regular collaboration system password. 
2 Select Tools > Set PIN code in the DME menu. 

If you cannot find this option, it is because the DME administrator has disabled it. 
3 A screen with three fields is shown: 

 
Enter your regular password in the top field Password, a PIN code of your own 
choice in the middle field New PIN code, and repeat your PIN code in the bottom 
field Confirm new PIN code to make sure you entered it correctly. 
The DME administrator has set a minimum length of the PIN code (between 4 and 
10 letters and numbers). 

4 Press Done to complete the PIN code definition. 
Now, when you want to log in, you have a choice of entering your regular password or 
your PIN code in the Login screen, where the Password field is now called 
Password/PIN code. 

 
The name of the password entry field in the Login screen will change back to 
Password when your PIN code expires. 
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To reset your PIN code, enter your password in the Set PIN code screen, but leave the 
PIN code field blank. Selecting Done will then show a message that the PIN code has 
been disabled. 

 Substituting password for swipe code 
1 Log in to the DME client using your regular collaboration system password. 
2 Select Tools > Set swipe code in the DME menu. 

If you cannot find this option, it is because the DME administrator has disabled it. 
3 The following screen consisting of 12 tiles is shown: 

 
4 Enter your regular password in the Password field 
5 Move your finger across any of the 12 tiles in the screen. For the pattern to 

become a valid swipe code, you must cover at least the number of tiles that are 
defined as the minimum PIN/swipe code length by the DME administrator. 

6 Repeat the swipe to confirm the new swipe code. 
If you accidentally move your finger across tiles that you did not intend to touch, 
you can undo the current swipe by continuing to move your finger outside the 
swipe area. You can then try again. 

Tap OK to close the swipe code definition screen. Your new swipe code is set. 
 

Settings 
When a new device is created in DME, a set of default settings for the device is sent to 
the client the first time the device connects with the server, or when a new user takes 
over an existing device. These settings should represent your company's security 
policy.  
Note that the DME administrator may have blocked your access to changing any or all 
of the settings described in the following sections. When a "permitted range" is 
mentioned in the following sections, the range may in fact have been changed by the 
DME administrator. 
The "Deployment guide" contains information for DME administrators about 
recommended settings and permitted range values. 
 

General settings 
 Launch on startup 

Select Yes/Enabled to make the DME client launch every time you start your 
device. This is default and highly recommended for security purposes. 
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Select No/Disabled if you want to start the DME client manually. 
 Phone number 

The phone number of the device. The DME server needs to know your phone 
number for sending SMS messages and pushing downloads etc. to the device. 

 Server path 
This is the path to the DME server. You set this value once, the first time you start 
DME. The server path should rarely be changed, and only if your DME 
Administrator tells you to. For more information, see First-time login on page 26. 

 Network push 
If this function is enabled, the device is set up to receive network (IP) push. This 
means that notifications are received over the GPRS network instead of by SMS. 
The result is faster and usually cheaper notification. This requires that the DME 
server is set up correctly. If the GPRS network is for some reason unavailable, the 
DME server will detect this and send notifications by SMS instead. This system of 
falling back to SMS is called AdaptivePush™. Whenever network push is enabled 
and working on your device, a flash icon  is displayed next to the DME logo at 
the top of your DME client. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming on page 19. 
 Network push path 

If network (IP) push is enabled, you must supply a path to the server providing 
the network push connection. This path is usually pushed to your device by the 
DME server. Please contact your DME administrator for more information. 

 IM awareness 
If your company uses the IBM Sametime instant messaging (IM) application, 
you can select this field to see the Sametime status of your Sametime contacts 
(buddy list). If you do this, a symbol next to the name of the sender of an 
e-mail in a mailbox indicates his or her Sametime status: Away , In a meeting 

, Do not disturb , or Available . Please note that in order to use this feature, 
Network push must be enabled as well (see above). 

 Login Close key 
In this field you can specify the action of the secondary key when the Login 
screen is shown. The following choices are available: 
 Exit: This is the default setting. Pressing the secondary key exits the DME 

application. 
 Hide: If you select this option, pressing the secondary key will hide (minimize) 

DME without logging out the user. This corresponds to pressing the red 
end-call key. Note that by selecting this, both the Exit action and the Login 
action are moved in as sub-items in the DME menu. 

 Desktop Close key 
In this field you can specify the action of the secondary key when the Desktop is 
shown. The following choices are available: 
 Lock: This is the default setting. Pressing the secondary key from the Desktop 

locks DME and shows the Login screen. 
 Hide: If you select this option, pressing the secondary key will hide (minimize) 

DME without logging out the user. This corresponds to pressing the red 
end-call key. 
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 Allow sync when roaming 
If this field is set to Disabled, you will not be able to perform manual 
synchronization when using a roaming network. When roaming, you will see a 
message saying that synchronization is not allowed when roaming if you try to 
perform a manual synchronization. 
The device uses information from the SIM card when checking if it is currently 
roaming. As soon as the phone is no longer roaming, you are able to synchronize 
manually again. Performing a manual sync will also inform the server that the 
device is no longer roaming, which is necessary for re-enabling background sync. 
See also Bgr. sync when roaming. 
This setting is for your information only - it cannot be changed from the device. 

 Bgr. sync when roaming 
If this field is set to Disabled, the device will not perform background 
synchronization when using a roaming network. Background synchronization 
covers scheduled synchronization, e-mail and PIM pull, and SMS push 
notification. If Allow sync when roaming is enabled, you will still be able to 
synchronize manually. 
The roaming status of the device is stored on the server. The first background sync 
performed while roaming will therefore be carried out normally, but will also 
inform the server that the device is roaming, effectively cutting the device off from 
further background synchronization. This means that the server is unable to detect 
that the device is back in the home network, unless you perform a manual sync. 
When using this cost-saving feature, it is important to that you perform a manual 
sync when you return to your home network. 
This setting is for your information only - it cannot be changed from the device. 

 Network push when roaming 
As a cost-saving feature, the administrator can disable the network (IP) connection 
when the device is roaming by setting this option to Disabled. If the server setting 
Notify when roaming is enabled, the server will resort to SMS push (if permitted 
by the notification schedule that applies to the device). If Notify when roaming is 
disabled also, the device will receive no notification at all. 
To update the roaming status, you should perform a manual synchronization when 
you return to your home network. 
This setting is for your information only - it cannot be changed from the device. 

 

Security settings 
With these settings, you specify the security aspects of DME on your device. 
 Action on SIM change 

In this field you can choose how the DME client should react when a new SIM 
card is inserted into the device. You may need more than one SIM card, for 
instance if you travel and use local prepaid SIM cards. However, simply allowing 
SIM card changes poses a security threat, as a malevolent user might steal a device 
and insert his own SIM card in order to (potentially) gain access to files and other 
data on the device. Therefore you can choose among three options in this field: 
 None 

If you select this option, the DME client will do nothing when a user changes 
SIM cards. This is usually not recommended for the above stated reasons. 

 Flush data 
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If you select this option, the DME client will flush (delete all DME data from) 
the device if another SIM card is inserted. For more information, see Data 
security on page 9. 

 Client certificate 
If Client signing is enabled on the DME server, you can only establish a 
connection with the server if your device is known and trusted by the server. This 
is achieved through a system of certificates. If a new certificate is generated for the 
device, you will need to delete the existing certificate on your device. If the value 
in this field is Select to remove, a client certificate is in force on your device, and 
you can delete it. You should only do this if you are asked to do so by a DME 
Administrator, as you will not be able to log on again until the DME Administrator 
initiates the creation of a new certificate. 

 Private key password 
In this field you can specify your password for your private key. Your private key 
is used for decrypting encrypted messages sent to you, and for signing private 
messages. If you do not enter a password here, you cannot read encrypted 
messages or sign new messages from your mobile device. 
If your collaboration system is using Notes Encryption, you must enter the 
password for your user ID file. 
If your collaboration system is using S/MIME, enter the password for your private 
key in this field. You must also upload your personal certificate to the DME server 
(using myDME).  
For more information about Notes Encryption, S/MIME, and myDME, please 
contact your DME administrator. 

 Logout timeout (min) 
The DME client is locked automatically after the specified number of minutes of 
inactivity. The value 0 means never logout automatically (not recommended). 
Permitted range: 0-60 minutes. 

 

E-mail settings 
In the e-mail settings screen you specify the synchronization and other aspects of 
e-mail in the DME client on your device. 
 E-mail sync. 

If you select Enabled/On, e-mail synchronization is enabled. This setting affects 
push mail, e-mail pull, manual synchronization, and scheduled sync. 
If you select Disabled/Off, e-mails are never synchronized. 

 Days back 
When e-mails are synchronized, e-mails from the last number of days selected 
here will be synchronized and available in the Inbox. Permitted range: 0-99 days. 

 Send immediately 
If you select No, e-mails are stored in the Outbox folder when you select Send, 
and are not sent until the next scheduled or manual synchronization. 
If you select Send only, e-mails created on the device are sent immediately when 
you select Send from a new e-mail or meeting invitation, but any new items are 
not retrieved from the server. This significantly reduces the load on the server and 
the time it takes to synchronize. 
If you select Send & Retrieve, e-mails created on the device are sent immediately 
when you select Send from a new e-mail or meeting invitation - that is, a regular 
e-mail synchronization is performed. 
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 Delete only locally 
If you select Yes/On, e-mails deleted from the DME client will only be deleted on 
the device, and not on the collaboration system. This is the default. 
If you select No/Off, e-mails deleted on the client will be removed from both the 
DME client and the mail system at the next scheduled or manual synchronization. 
Mail alert options: 

 Sound on 
If you select this check box, the device will play the sound selected in the field 
Mail alert when you receive an e-mail in DME. 
 Start time 

In this field you can specify the time of day from which you want to begin 
receiving audible alerts when a new e-mail arrives. Use the local time format, 
for instance hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 
In this field you can specify the time of day from which you no longer want to 
receive audible alerts when a new e-mail arrives. Use the local time format, for 
instance hh:mm:ss or hh:mm:ss am/pm. Example: 18:00 or 06:00 am. 

 Mail alert 
Tap this option to select which sound you want hear when you receive a new 
mail in DME. Requires that Sound on is enabled. 

 Alert volume 
In this field you can specify the volume of the alerts you hear when a new 
e-mail arrives. 

 Vibrate 
If you enable this option, the device vibrator will be activated when a new mail 
is received by DME. 

 Show received time 
If you select Yes, a column is added to the mailbox folders with the date on which 
the e-mail was sent or received. 
E-mail pull options: 

 E-mail pull 
If you select Enabled, client-initiated (pull) synchronization of e-mail is enabled. 
This corresponds to the Scheduled sync. settings on page 76, but is independent of 
the synchronization schedule set up on the DME server. 
Select Disabled to disable the client-initiated sync. of e-mail. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming on page 19. 
 Pull interval 

If E-mail pull is enabled, the client will initiate a sync. every number of 
minutes selected here. Permitted range: 10-120 minutes. 

 Start time 
In this field you can specify the time of day after which client-initiated pull 
should start, if this is enabled. Use the local time format, for instance 
hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 
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In this field you can specify the time of day at which client-initiated pull 
should end, if this is enabled. Use the local time format, for instance hh:mm:ss 
or hh:mm:ss am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, client-initiated pull will continue to run over the weekend. 
If you select No, client-initiated pull will not run on weekends. 

Signature options: 
 Signature 

Any text you enter in this field will be appended to all new e-mails sent from the 
DME client. You typically use it for adding a signature. Note that the DME 
administrator can add another text to be appended to e-mails, called an "E-mail 
disclaimer". DME will add the signature from this field first, and then the e-mail 
disclaimer will be added by the DME server at the very end of the e-mail (after 
any reply history). 

 

Folders settings 
The folder settings screen is only visible if the DME administrator has enabled folder 
synchronization on the server. If enabled, you are able to view your mailbox folders 
(as created in Outlook or Notes) and any e-mails in these folders on the device. 
This screen contains settings which act as default settings for all folders. From this 
screen you can also force the default settings on all mailbox folders.  
In the Folders screen, you can apply different settings to individual folders (see 
Setting folder options). In the individual folder setup screen, you can also flush the 
individual settings and re-apply the default settings, which are made in this screen. 
 Folders sync. 

In this field you can choose to enable synchronization of e-mails in subfolders by 
default. The e-mails are synchronized for the number of days specified in the Days 
back field. You can change the setting for individual e-mail folders (see Setting 
folder options). 
Regardless of this setting, the folder structure as such (without e-mails) is 
synchronized between the collaboration system and the device. You need the 
folder structure when choosing where to search for e-mails on the server - see 
E-mails (on server) on page 43 and for moving e-mails to other folders. 

 Days back 
In this field you can specify how many days back the DME client should 
synchronize e-mails in subfolders. Note that with higher numbers, the load on the 
DME server will increase. This number may be changed for individual folders. 

 Apply to all folders now 
This option will always be off when you open the folder settings tab. Think of this 
option as an action button - if you select it, the settings for Days back and Sync. 
folders made in this window will be applied to all folders instantly, regardless of 
their individual settings. This is a way to realign all folder settings with default 
values. 

 

Calendar settings 
In the calendar settings, you specify the synchronization and other aspects of calendar 
items in the DME client on your device. 



74 
 

DME Client User Guide 3.5.8 : ©2011 Excitor A/S 
 

 Calendar sync. 
If you select Enabled, calendar synchronization is enabled. This setting affects 
push notification, calendar pull, manual synchronization, and scheduled sync. 
If you select Disabled, calendar items are never synchronized. 

 Days back 
When items are synchronized, items from the last number of days selected here 
will be synchronized and available in the device. 

 Days forward 
When items are synchronized, items up until the number of days selected here will 
be synchronized and available in the Calendar. 

 Alarm sound 
If you enable this setting, DME will play the default calendar alarm when 
displaying a calendar alert. 

 Set alarm sound 
With this setting, you can choose which sound among the installed ringtones you 
want to use as calendar alarm. 

 Vibrate 
If you enable this setting, DME will activate the phone vibrator when displaying a 
calendar alert. 

 Flashing LED 
If you enable this setting, DME will flash the LED light when displaying a 
calendar alert (not all devices support this feature). 
Calendar pull options: 

 Calendar pull 
If you select Enable, client-initiated (pull) synchronization of calendar items is 
enabled. This corresponds to the Scheduled sync. settings on page 76, but is 
independent of the synchronization schedule set up on the DME server. 
Select Disable to disable the client-initiated sync. of calendar items. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming on page 19. 
 Pull interval 

If Calendar pull is enabled, the client will initiate a sync. every number of 
minutes selected here. 

 Start time 
In this field you can specify the time of day after which client-initiated pull 
should start, if this is enabled. Use the local time format, for instance 
hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 
In this field you can specify the time of day at which client-initiated pull 
should end, if this is enabled. Use the local time format, for instance hh:mm:ss 
or hh:mm:ss am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, client-initiated pull will continue to run over the weekend. 
If you select No, client-initiated pull will not run on weekends. 
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Contacts sync. settings 
 Contacts sync. 

If you select Enabled/On, contact synchronization is enabled, and your list of 
contacts on the device will be kept in sync with your personal address book on the 
collaboration system. 
If you select Disabled/Off, contacts are never synchronized. 

 Device Address Book 
With the settings in these fields you can choose how DME should interact with the 
native address book on your device - the Contacts application. DME contains an 
internal address book - the DME Address Book. You can choose to keep your 
business contacts in the DME Address Book and your private contacts in the 
native Contacts application - for reasons of security, work/life balance, or both. 
The degree of interaction can be chosen at three levels: 
 Copy all fields: Contacts from DME are shown in the native Contacts 

application, and the two address books are kept synchronized insofar as the 
native contacts application supports the DME address book fields. Note that 
when you select this option, DME will start exporting contacts to the Contacts 
application immediately. 

 Copy name and phone numbers: As Copy all fields, but only the name and 
phone numbers from the DME Address Book are shown in the native Contacts 
application. If you edit the name or phone number in your native Contacts 
application, this information will be synchronized to the DME Address Book. 
However, if you add any other information to your native contacts, this 
information will be removed again by DME. In other words, you should use 
DME for maintaining your contacts. Note that when you select this option, 
DME will process the contacts in the Contacts application immediately, so 
they only show name and number. 

 Don't use: There is no interaction - contacts in the DME Address Book and 
the native Contacts are kept completely separate. This lets you keep your 
business contacts in DME in sync with your collaboration system, while 
letting you synchronize your personal contacts with other contact 
synchronization applications. Note that when you select this option, DME will 
delete any contacts in the Contacts application, which are also found in the 
DME Address Book, immediately. 

For more information, see Interaction with the device Contacts. 
 

Files settings 
With this setting, you enable or disable the synchronization of files. File 
synchronization requires a special license and is set up on the DME server. For more 
information, please ask your DME administrator. 
 File sync. 

If you select Enabled, file synchronization is enabled. This setting affects push 
notification, manual synchronization, and scheduled sync. 
If you select Disabled, files are never synchronized. 
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Scheduled sync. settings 
With these settings, you specify options for scheduled synchronization. Note that this 
feature may be disabled if you are roaming. For more information, see Roaming on 
page 19. 
 Scheduled sync. 

If you select Enabled, the DME client will initiate synchronization of the enabled 
resources (e-mail, calendar, etc.) according to the schedule specified below. 
If you select Disabled, the synchronization of resources relies on client-initiated 
sync (pull, where applicable), manual synchronization, or push notification from 
the mail system. 

 Interval 
If Scheduled sync. is enabled, the client will accept a sync. every number of hours 
selected here. Permitted range: 1-24 hours. 

 Start time 
In this field you can specify the time of day after which scheduled sync. should 
start, if this is enabled. Use the local time format, for instance hh:mm:ss or 
hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 
In this field you can specify the time of day at which scheduled sync. should end, 
if this is enabled. Use the local time format, for instance hh:mm:ss or hh:mm:ss 
am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, scheduled sync. will continue to run over the weekend. 
If you select No, scheduled sync. will not run on weekends. 

 

Desktop settings 
 Log in to 

In this field you can specify which screen you want to see after logging in to the 
DME client. You can choose between the following options: 
 Last Used: DME remembers which of the below views was active when you 

last logged out of DME, and starts here when you log in again. 
 Desktop: DME starts in the Desktop view after logging in. 
 Inbox: DME opens the Inbox after logging in. 
 Calendar: DME opens the Calendar after logging in. 
For more information, see The DME Desktop on page 28. 

 Startup sound 
If this field is set to Enabled, DME will play a sound when you launch the client. 
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Menu tree 
If you have access to the full DME client, the menu structure of the DME client is as 
follows. Note that the DME menu structure is dynamic. If your license does not 
include all functionality, or if some functionality is turned off by the DME 
Administrator, there will be less menu items than shown below. 
 

Create 
 E-mail 

Create a new e-mail. 
 Meeting 

Create a new meeting invitation or appointment. 
 

Synchronize 
 E-mail 

Synchronize e-mails only. 
 Calendar 

Synchronize calendar items only. 
 Contacts 

Synchronize contacts only. 
 To-do 

Synchronize to-dos (tasks) only. 
 Files 

Synchronize files only, if enabled. 
 Sync. all 

Synchronize all resources. 
 Cancel sync. 

Cancel an ongoing synchronization. Any changes made will be rolled back. 
 

Search 
 Global Address Book 

Search for e-mail address on the server. 
 E-mails (on server) 

Search for e-mails in your server mailbox. 
 E-mails (on phone) 

Search for e-mails stored locally. 
 

Actions 
 Delete selected 

(If item is selected) Delete the current item. 
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 Mark selected read 
(If item is selected) Mark selected items as read. 

 Mark all read 
(If no item is selected) Mark all items as read. 

 Mark selected unread 
(If item is selected) Mark selected items as unread. 

 Mark all unread 
(If no item is selected) Mark all items as unread. 

 Move to folder 
(If item is selected) Move the current item to another folder. 

 Mark as follow-up 
(If item is selected) Flag selected items as follow-up items. 

 Unmark as follow-up 
(If item is selected) Remove follow-up flag from selected items. 

 Delete all attachments 
(If no item is selected) Removes all downloaded attachments from the phone. 

 
 

View 
 Folders 

Go to the Folders view, where you can choose which mailbox folder you want to 
work in. 

 Calendar 
Go to the internal DME calendar. 

 Contacts 
Go to the internal DME contacts. 

 To-do 
Go to the to-do list. 

 

Tools 
 Settings 

Set up different aspects of DME on your device: General, Security, E-mail, Folders, 
Calendar, Contacts, To-dos, Files, Scheduled sync., Desktop. 

 Reset 
Reset (wipe and load) all synchronized items from the collaboration system to 
your device. 

 Out of office 
Manage your out of office agent or rule. 

 Change password 
Change your LDAP/AD password to match that on the server. 

 Set PIN code 
Set a PIN code as a temporary double of your LDAP password. 

 Set swipe code 
Set a swipe gesture as a temporary replacement for your LDAP password. 
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 Log 
Show the client's event log, and optionally save it as a file. 

See Tools for more information. 
 

More 
 Lock 

Lock DME (log out). 
 Hide 

Hide DME (move DME to background, but remain logged in). 
 About DME 

Display version information, OS information, and license agreement text. 
 





 

  If you need further assistance   

If you need further assistance 
If you have read this guide and still have questions concerning the function and use of 
the DME client, please contact your DME administrator (usually the internal IT 
department). 
Before contacting your DME administrator, be sure to have information about your 
DME version etc. ready.  

 Showing the current version of your DME client 
1 Open the DME menu (iPhone: tap Tools). 
2 Select About DME. 

 

 
DME keeps a log of the events that take place in the client. 

 Showing the DME client event log 
1 Open the DME menu (iPhone: Go to Desktop or a mailbox folder). 

2 Select Tools / . 
3 Select Log. 

 

 
If you are using the DME client for Windows Mobile, Java, or iPhone, you can tap 
Send log (iPhone: tap ) to insert the log text into a new e-mail, which you can then 
send to your Helpdesk. 
If you are using the DME client for Android, you can tap the Menu key, and tap the 
diskette icon to save the log to the file /sdcard/me/log.txt on the memory card. 
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Please note that the DME administrator can request the client log using a feature in the 
DME Server (not iPhone). 
If you are the DME administrator, you can contact your DME partner. 
You can also check the DME Support http://www.excitor.com website for more 
information. 
If you find errors or omissions in this documentation, please contact Documentation 
feedback see Documentation feedback - 
mailto:documentation@excitor.com?Subject=Documentation feedback. 
 

http://www.excitor.com/
mailto:documentation@excitor.com?Subject=Documentation%20feedback
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